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Getting Started In LeachXS Pro 

Welcome to LeachXS Pro. This manual helps you in using LeachXS. If you already have entered your 

license details and LeachXS has started successfully, go to “The Main Screen” on page 2. If you have 

trouble with your license read the section below. 

Your license 

The welcome screen is displayed right after LeachXS is started and will remain visible until your license is 

validated. Normally, it displays the software version number and release date, and the name of the 

licensed user. 

When started for the first time, LeachXS will prompt you to provide your license data you received along 

with your version of LeachXS. Supply the name of the licensed user or company and the accompanying 

license key. Be sure that your system has working Internet connection, because LeachXS will verify your 

license by querying a central license host. 

Depending on the configuration of your firewall and the settings of the Internet options in the 

configuration panel of your system, LeachXS may ask you to supply the name of the proxy server and the 

proxy address. Usually, your system administrator will be able to supply this information. 

License verification 

Because you have a license for a limited number of copies and a limited amount of time, LeachXS will try 

to verify your license every time you start it. However, this doesn't mean that you need to have an 

Internet connection available all the time. If you don't have an active connection when you start 

LeachXS, it will skip the verification stage if the last time a successful validation has been taken place is 

less than 15 days ago. Only if the last successful validation was more than 15 days ago and there is still 

no Internet connection available, LeachXS will refuse to continue. 

Verification steps 

During the verification stage, LeachXS will check if your license is valid. Your license is valid if: 

1. The number of installed copies of the license does not exceed the number of licenses you have. 

2. The expiration date of your license has not been exceeded. 

Note that a single license will allow you to install LeachXS on at most two different systems. 

Obtaining verification information 

After the installation of LeachXS a separate entry is created in the LeachXS programs section in your 

start menu: License Validation. You can use this validation program to: 
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 Inspect details of the verification procedure. A popup window will appear with the requests to and 

answers from the central license host. 

 Force validation. This is useful when you are about to use your computer for a while without having 

an Internet connection. After a successful validation procedure, it is guaranteed that you can use 

LeachXS for 15 days before a next validation procedure is mandatory. 

Note that this is the only way to guarantee a 15-day usage: the normal LeachXS program doesn't verify 

your license if the last verification has been less than 3 days ago, thus speeding up the startup process. 

The Main Screen 

The main screen (see screen capture below) is the entry point into LeachXS. This is the primary 

navigation screen that contains the roll-up menu for accessing the major operations in the software. The 

top menu bar contains tabs for database management, exporting data for reports, tools for changing the 

look and feel of data output and import “cases” from other LeachXS users. See the section “LeachXS 

Cases and Case Management” on page 100  in the guide for more details on cases. 

 

In the screen capture above, note that the database tab is selected and the current database, 

Development CBP database Sept_2013, is indicated in the upper left corner of the screen. This database 

is one of two default databases in LeachXS v2.0.0. An alternative default database is the EPA CCRs dbase 

(USEPA CCR 12-2009.mdb). 

Roll up Menu
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The main screen roll-up menu comprises the primary navigation menu in LeachXS with the following 

possible selections: 

Welcome 

Returns the user to the main screen as shown above. 
Analyze, Compare and Display Leaching Data 

Used to compare leaching data between replicates of a single material or different materials. 
Acid/Base Neutralization Capacity 

Used to calculate acid/base titrations and project final pH based on the test data obtained from 
pH dependence testing. 

Import or Add New Data 

Used to import new material data (e.g., total contents, leaching test results) into an existing or 
user created database. 

Classic LeachXS Modeling 

Used to access chemical speciation and pH-dependent prediction modeling. 
Advanced Modeling 

Used to access more complex multi-phenomena models. 
 

The majority of this guide will follow the main navigation roll-up menu for v2.0.0 of LeachXS Pro. 

Switching Databases in LeachXS 

Switching databases in LeachXS can be accomplished only from the main screen by selecting the 

Database tab in the top menu bar. The current database is show on the left side of the menu ribbon 

(e.g., see the red circle showing the USEPA CCRs 12-2009 rev 1.mdb database in this example). To 

switch to an alternative database (e.g., the Development CBP database Sept_2013), click the Select 

other database… icon and navigate to the new database using the pop-up browser window. 
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The default LeachXS databases are stored in a DATABASES folder within the LeachXS User Object folder. 

User-created databases can be stored anywhere on the computer. The location of the default databases 

folder on the computer is: 

My Documents\LeachXS User Objects\DATABASES 

The graphical example below shows the procedure for selection of the 

Development CBP database Sept_2013 database. From the pop-up browser window, the target 

database is highlighted by clicking on the name of the database in the proper folder and opened by 

clicking the Open button at the bottom of the browser window.  

 

This action will make Development CBP database Sept_2013 the current database in LeachXS. 

#1 Select the 

new database 

#2 Click “Open” 

Button 
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LeachXS maintains a history of databases you use. You can select a previously used database by clicking 

on the top left LeachXS logo. 

Note that a list of objects that are previously used appears in many dialogs of LeachXS. 

Getting Data In and Out of LeachXS 

The default databases in LeachXS contain leaching test and material property data collected from a 

broad range of studies and projects. The user can compare their own data to selected data within these 

default databases by importing their data into the database. Microsoft Excel® workbooks used as the 

basis for uploading data into LeachXS are provided in the form of Microsoft Excel® templates for each of 

the leaching tests in the Leaching Environmental Assessment Framework (e.g., EPA Methods 1313 

through 1316). Comparison graphs and numerical data prepared in LeachXS may be exported to 

Microsoft Excel® workbooks. In addition, LeachXS Pro has the capability to allow users to share “cases” 

with another user. 

Naming Conventions in LeachXS 

The material name is specified in the Microsoft Excel® data template prior to loading data into LeachXS. 

When loaded into the software, a parenthetic extension is added to each test replicate indicating the 

type of data, the material replicate, and the test replicate. Replicate tests are stored as separate 

“materials” within the database distinguished by the test replicate identifier in the extension. The 

extension includes a letter (i.e., “P” for pH-dependent data, “C” for percolation column data, “B” for 

batch L/S dependent data, and “M” for mass transport data) followed by two numbers. The first number 

indicates the replication of the solid material sampling (e.g., “1” for the 1st sampling, etc.) while the 

second number indicates the replication of the test method (e.g., “2” for the 2nd test replicate, etc.). 

Global window layout 

Many editors and windows in LeachXS have a common layout. 
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Application logo 

If you click on the Application logo, a small window will pop up with two panes. The left pane contains 

functions for copying the window or the entire screen to the clipboard or printer and for closing the 

window. The right pane contains the most recently used cases (see “LeachXS Cases and Case 

Management” on page 100 for an explanation of what a case is). If you click on a case it will be opened 

in the editor or window. 

Quick Access Toolbar 

The Quick Access Toolbar is expanded if you click on it. It contains the same functions as the left pane of 

the Application logo. In addition, there are functions to manipulate the position and behavior of the 

ribbon bar. Many editors have two small icons to save or cancel edit operations: 

 

Pressing the green icon will save your changes and close the editor. The red icon cancels all edit 

operations before closing. 

Application 

logo 
Quick Access 

Toolbar 
Ribbon menu with 

ribbon bar 

Database Current case Changed indicator 
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Note that you can add your own buttons to this toolbar: right-click any button on the ribbon bar and select 

Add to Quick Access Toolbar. 

Ribbon menu with ribbon bar 

The ribbon menu contains most functions that are available in a window or editor. Related functions are 

grouped together in ribbon tabs and within a tab, organized in tab groups. Many editors have a tab Case 

Manager for saving cases and loading previously saved ones. 

Changed indicator 

This small icon shows up if you have made any changes in the data that is presented. 

Current case 

This part of the window displays the current case you are working on. 

Database 

If you keep your mouse steady on this icon, a small window pops up with information on the database 

that is currently selected in LeachXS. 
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Analyze, Compare and Display Leaching Data 

Data visualization, comparison and reporting are conducted by selecting Analyze, Compare and Display 

Leaching Data. The following menu screen results: 

 

The Analyze, Compare, and Display Leaching Data menu screen provides options for: 

Compare Materials for Selected Constituents 

View and analyze the results of leaching tests for a single constituent for one or more materials 

or material replicates. Links provide access to Analysis and Presentation windows for Granular 

Materials and Monolithic Materials. 

Compare Constituents from a Selected Material 

View and analyze the results of leaching tests for multiple constituents in a single material or 

material replicate. Links provide access to Analysis and Presentation windows for Granular 

Materials and Monolithic Materials. 

Field Monitoring Data 

Compare field data as time series or scale-up series from field measurements. 
This section is not described in this version of the guide. 

Statistics and Quality Control 

Analysis of material sets relative to statistical representations and quality control objectives. 

This section is not described in this version of the guide. 
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Displaying the Results of Leaching Data 

The operation for comparing leaching test results is similar for both granular and monolithic materials. 

Therefore, the procedure for displaying leaching data will be shown through an example of comparing 

results for granular materials. To compare leaching test results for one or more granular materials, 

select Granular Materials (pH and L/S dependence) link under the Compare Materials for Selected 

Constituents title. 

 

The following Granular Materials Comparison window is displayed. 

Select to display 
leaching data
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The Analysis and Presentation window is divided into four zones with stepwise guidance for each zone. 

The process for displaying data includes: 

Step 1  Select data to be displayed as a function of pH and options for displaying the data (if 
comparison of pH-dependence is not desired, this step may be skipped) 

Step 2 Select data to be displayed as a function of L/S and options for displaying the data (if 
comparison of L/S dependent data is not desired, this step may be skipped) 

Step 3 Select a constituent to be compared (mandatory) 

Step 4 View or Export the selected data. 

Selecting Data from the Database 

The example below will illustrate the process of selecting datasets from the current database for 

comparison, although the process is the similar for selecting percolation or L/S data. Begin the process 

of selecting pH dependent data by clicking on the Select… button in the Step 1 zone of the Granular 

Materials Comparison window. 
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The Sample Selector will show up: 

 

For a complete description of the Sample Selector, see chapter “The Sample Selector” on page 121. 

Select the same samples as shown in the screenshot above: 

 Cement VCO (vaults, CBP) (P, 1, 1) 

 Cement VCO (vaults, CBP) (P, 1, 2) 

 Cement VCT (vaults, CBP) (P, 1, 1) 

 Cement VCT (vaults, CBP) (P, 1, 2) 
Be sure to select the pH Dependence tests of these materials. 
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Leave the Sample Selector by pressing the small green button in the top left corner. The samples will 

show up in the pH dependent Data list in the Comparison Window. 

 

Displaying Selected Data 

After selecting the data sets for comparison, the Granular Materials Comparison screen will show the 

date sets in the appropriate windows. The example below includes selected data for both pH dependent 

and percolation column data (selected through a similar series of steps initiated by clicking on the 

Select… button in the Step 2 zone). 

 

If desired, modify the graphs to be displayed by marking the check boxes on the Display Units under 

Step 1 and the Graphing Options under Step 2. Multiple graphs may be shown at one time. Data plotted 
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as a function of pH may be displayed as concentration in units of mg/L or as mass release in units of 

mg/kg. For L/S dependent data, the eluate pH, concentration, or release may be plotted as a function of 

L/S. 

 

In the Step 3: Select Constituent zone, select a constituent to display by clicking on the Select button. 

 

The Constituent Selector will show up to assist you in selecting a constituent. 
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For a complete description of the Constituent Selector, see chapter “The Constituent Selector” on page 

128. 

Select constituent Ca as in the example and hit the small green button in the top left corner. 

The last step before displaying data is to click the View Graph button as indicated below. 

 

The following is an example display of selected data: 
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This graph window is detached from the Granular Materials Comparison window. This means that you 

can make another comparison, show its graphs and compare that window with the one above. 

In order to edit the way that LeachXS formats the graphs displayed when the View Graph button is 

selected, the graph format for each type of figure can be modified using the Graphs Layout function on 

the top ribbon bar. 

Exporting Charts to Microsoft Excel® 

When the charts displayed by the View Charts button have been edited as desired, the charts and 

associated data shown may be export to Microsoft Excel® from the View Graph screen using the menu 

ribbon under the Export tab on the top menu bar highlighted in the example below. 
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To export an individual pane in the output window, click within the white area to highlight it and then 

select Export Selection. To export the all charts, select Export All. Follow the instructions on the 

resultant Export Charts screen shown below. 

 

Output data may be written to a new Microsoft Excel® workbook for the output by clicking on the New 

icon and designating a filename and location. Alternatively, output data can be overwritten to an 

existing Microsoft Excel® workbook by clicking on the Pick icon and navigating to an existing workbook. 

An available option is the ability to rename the samples as they will appear in the Microsoft Excel® sheet 

by marking the check box next to Use alternative material names and designating new names for the 

data sets in the pop-up window (see example below). Sample properties for the output materials can be 

included in a separate worksheet in the output workbook by checking Report material attributes (not 
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checked in the example). When all desired options, click on the Export button to generate the output 

Microsoft Excel® file. 

 

Depending on the amount of information for output, generating an output Excel file may take several 

minutes. A green progress bar will be shown to the left of the Export button. When the export is 

complete, click the Show button on the View group of the Workbook tab on the ribbon menu to open 

the resulting Microsoft Excel® workbook. 

 

Data for multiple constituents may be exported to Microsoft Excel® using the Bulk Export button in the 

Granular Materials Comparison window in a similar manner.  

#1 Select Excel workbook 

(new or existing) 

#2a Rename data series 

(optional) 

#2b Assign alternative 

names (optional) 
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Modifying Display and Export Figure Properties 

The layout of data series displayed in LeachXS or imported from LeachXS can be modified using the 

Material Line Scheme menu on the Granular Materials Comparison screen. The example illustrates 

formatting for pH dependent data; however the same process can be used to format percolation or L/S 

dependent data from this screen as well as monolithic data from the Monolithic Materials Comparison 

screen. 

 

The following buttons are available from the Material Line Scheme menu: 

Default Returns all display settings to their initial condition. 

Edit… Allows for editing of established line settings. 

Select… Allows for definition of line schemes for each data series. 
 

The Material Line Scheme Editor is displayed after clicking on the Select… button from the Material 

Line Scheme pane. For a complete description, see “The Material Line Scheme Editor” on page 142. 

Saving your work 

You can save your selections, along with all other options you have set in a file and open or reuse it 

later. Such a file is called a Case. All case management functions can be accessed from the Case 

Manager tab on the ribbon bar. For more information about cases and the Case Manager, see “LeachXS 

Cases and Case Management” on page 100. 
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Graph Appearances 

The Graphs Layout tab contains options to control how chart elements will appear. You can control the 

layout of every type of graph, save layouts for later use and change default settings for every graph 

type. 

 

The left side of the tab page shows a box containing the type of graph to edit. Click on the down-

pointing arrow to select the type whose layout you want to change. 

Next to it there is the Default Layout button. Pressing this button will reset the current layout to the 

layout that is shipped with the installation setup of LeachXS. 

Then there is the Edit… button. The following windows will appear: 
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The left pane of this window contains chart elements. Clicking on a chart element will show options to 

control the appearance of the element in the pane right to it. Next to the Chart Layout Editor you see an 

example of how the chart will look like, given the option values in the editor. 

The rectangles to the right of a Color option are buttons. You can change a color by clicking on the 

rectangle. The fields to the right of a Font label are also buttons. You can change a font by clicking on 

the label. 

Other options on the Graphs Layout tab are: 

Set as Default Layout Set the graph layout of the selected graph as default layout for 
new cases. 

Default Layouts Set layouts for all selectable graphs to their default layouts. 
From Other Comparison… Set all layouts of the graphs of the current case to the layouts of 

another case. The Case Manager will show up to help you 
selecting a case. 

Set as Default Layouts Make the graph layouts of all graphs in the current case the 
default layout for new cases. 

More Options 

There are quite some options to enhance the graphs and reports with extra data or to control how they 

will look like. 

General Options 

Some options are located in the ribbon bar. These options are described here.  

The Values below DTL tab contains a list of options how to show values below the detection limit are 

treated in reports and graphs: 

 Use detection limit will report and display concentration values below the detection limit as the 

detection limit value. 

 Use half of the detection limit will report and display concentration values below the detection limit 

as half of the detection limit value. 

 Use the concentration will report and display concentrations values below the detection limit not 

different from other concentration values: the concentration value as stored in the sample database 

is shown. 

Step 1 options 

These options apply to the presentation of pH dependent data. 

Add overall polynomial fit curve A least-squares polynomial is drawn through the data 
points. 

Include percolated materials in graph If you have selected any samples in step 2 
(percolation L/S data), the concentrations or 
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emissions of these samples are included in the pH 
dependence graphs. 

Show total composition, if available If this option is checked, total composition values are 
included in the pH dependence graphs. You can check 
if the selected samples have composition data in your 
database by pressing the Usage… button. 

Show availability, if available If this option is checked, availability values are 
included in the pH dependence graphs. You can check 
if the selected samples have availability data in your 
database by pressing the Usage… button. 

Step 2 options 

These options apply to the presentation of percolation L/S data. You can add curves to concentrations 

and cumulative releases.  

The Show fitted E values option uses the following formula: 



 )1( )/(

0
/

SL

SL

eC
E


   where L/S is in L/kg and EL/S in mg/kg. 

 

The Show fitted exponential model values option uses a simple CSTR model that fits the percolation 

data using a least squares fitting routine. The calculated concentrations are given at the sampled L/S 

data points. The coefficients are passed on to the Excel worksheet upon saving the data. See “File 

locations” on page 149 for details about how the values are obtained and for the meaning of the 

Weights that can be used. 

Step 3 options 

Use pH Dependent regulatory thresholds 

Comparison with regulatory criteria is an important issue in relation to leaching test data. Different 

directives are available, which can be used for judgment of test results. The units are mg/kg. The list of 

directives will be expanded in the future. Besides choosing from a list of predefined directives, you can 

create your own directives. Check this box if you want to use and display directive criteria in your 

graphs.  

The Select button will enable you to choose an appropriate directive. See “Directive selection dialog” on 

page 144 for details. Fill the Lower pH limit and the Upper pH limit text boxes for the appropriate pH 

range of the directive.  

If you have chosen multiple pH dependent materials, the concentrations for the constituent may not 

have the same detection limit for every material. In the Low threshold list you can select how the lower 

boundary of the directive criterion is to be calculated: as minimum, maximum or average of all detection 

limits found. 
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Include own pH 

If own pH (aka natural pH) values of the materials you selected are known or can be calculated from 

ANC/BNC data, you can check this option to make them visible in the graphs. They will appear as an 

asterisk in series. You can control what series will be accompanied by their own pH value. Press button 

Own pH… in the Step 1 pane. A small dialog will pop up. Use the check buttons in front of the samples 

to mark which samples will have an own pH value displayed. 

Note that if the asterisk is not lying on a measured data point of the series, the own pH value is calculated. 

The concentration at that point only is only indicative. 

Show indicator lines 

If you want to display extra guidance lines in your graphs indicating pH or concentration thresholds, you 

can check this option. For an explanation of indicator lines and how you can define them, see section 

“Indicator Lines Editor” on page 135. 
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Acid/Base Neutralization Capacity 

Clicking on the Acid/Base Neutralization Capacity roll-up menu item will result in the two menu options 

for (i) comparing the titration curve (i.e., the measured pH as a function of acid or base addition) and (ii) 

running the acid neutralization capacity (ANC) and base neutralization capacity (BNC) calculator. 

Compare Acid/Base Neutralization Capacities 

The acid/base titration curves for one or more materials may be viewed and exported using the 

Compare Acid/Base Neutralization Capacities link in the Acid/Base Neutralization Capacity roll-up 

menu. 

 

Materials to be compared may be selected using the screen below. Clicking on the Select button will 
activate the Select Samples window (see  “The Sample Selector” on page 121 for using the Select 
Samples window). 
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Note that LeachXS considers test replicates of the same solid sample to be different materials distinguished 

by the parenthetic extension added to each data series (see “Naming Conventions in LeachXS” on page 5 

for more information). 

When the material selection is complete, click the Next button to display the titration curves for the 

selected materials. 

 

The titration curve data may be exported to an Excel workbook by clicking on the Export button in the 

Acid/Base Neutralization Capacity Results screen to activate the Export Charts window (see ”Exporting 

Charts to Microsoft Excel®” on page 15 for more information on the Export Charts window). 
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Run the ANC/BNC Calculator 

The ANC/BNC Calculator uses the titration curve information to predict either (i) the final pH of a 

material given a starting pH and an addition of acid or base or (ii) the amount of acid or base required to 

change the pH of a material between to pH values. The ANC/BNC Calculator may be accessed from the 

Acid/Base Neutralization Capacity roll-up menu. 

 

Select one of the two calculation modes for the ANC/BNC Calculator by clicking on the appropriate radio 

button. Explanations for the operator of these modes are provided. 
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Calculate Acid/Base Additions 

If the Acid/Base Additions Mode is chosen, the following window will be displayed. The calculator works 

on a single material at a time, so the user will need to choose a material for analysis using the drop-

down menu of materials selected in the Materials Selection window. For a selected material, the user 

enters the starting and ending pH values and clicks the requires button to calculate the amount of acid 

or base needed to change the pH of the material. 

 

#1 Chose a material from 
the list of select materials

#2 Enter parameters for 
the calculation

#3 Click “requires” 
button calculate #4 Export results 

to Excel
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The resulting titration curve and the numerical data for this calculator may be exported to a Microsoft 

Excel® workbook using the Export Charts window accessed by clicking the Export button. 

Calculate Acid/Base Additions 

If the Final pH Mode is chosen, the following window will be displayed. The calculator works on a single 

material at a time, so the user will need to choose a material for analysis using the drop-down menu of 

materials selected in the Materials Selection window. For a selected material, the user enters an 

amount of acid or base to be added to the material and clicks the yields button to calculate the final pH 

of the material. 

Note: The ANC/BNC Calculator starts at the natural pH of the material; therefore, the amount of acid 

required to change the pH between two points that are not the natural pH can be determined by the 

difference of two calculator trials. For example, if the amount of acid required to change the pH from 8 to 

6 is desired for a material with a natural pH of 12, the amount would be the difference in the amounts of 

acid required in two trials – one pH 12 to 6 and one pH 12 to 8). 

In LeachXS, the “natural pH” (sometimes called the “own pH” for brevity) is defined as the pH response at 

a liquid-to-solid ratio of 10 L/kg when no acid or base is added. 

 

The resulting titration curve and the numerical data for this calculator may be exported to a Microsoft 

Excel® workbook using the Export Charts window accessed by clicking the Export button. 

#1 Chose a material from 
the list of select materials

#2 Enter parameters for 
the calculation

#3 Click “yields” button 
calculate #4 Export results 

to Excel
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Importing or Adding New Data 

If you want to work with leaching test results of your own, you’ll need to import them into a LeachXS 

database. LeachXS has quite a number of Excel templates that you can use to supply your data. All data 

import functions are collected in pane Import or Add New Data from the main window. 

A two-step process is involved in importing leaching data: 

 

 

First, all data in a Microsoft Excel® workbook is read and converted to an intermediate xml file structure. 

Then, the data in the xml file is imported into a database. You can choose to save the intermediate xml 

file. This is particularly useful if you want to distribute your data to other LeachXS users. 

The following options are available for importing data: 

From Existing Workbook 

Import new leaching data from Microsoft Excel® data templates. 
From Existing XML File 

Import new leaching data from a saved XML file. 
New Data (Using Data Template) 

Accesses blank Microsoft Excel® data templates for data entry from within the LeachXS 
program. 
This section is not described in this version of the guide. 

 

 

Import xml data 

into database 

Convert Excel workbook 

to xml file 
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Importing Data from a LEAF Template into a LeachXS Database 

Leaching data may be imported from Microsoft Excel® data templates provided LeachXS for archiving 

and importing laboratory and analytical data. Importing of data in LeachXS is initiated from the Import 

or Add New Data roll-up menu in the LeachXS main window (see example below). In the following 

example, import process will be demonstrated using data from EPA Method 1313 (Liquid-Solid 

Partitioning as a Function of Eluate pH); however, the same process is identical for each data template. 

To begin the procedure for importing data, select a link for the test type corresponding to data to be 

imported, for example, Method 1313 (pH Dependent Leaching). 

 

This action will activate a pop-up browser window. Using the browser, navigate the desired data 

template and select the Open button to start the import tool. A Data Import Logger window will pop up 

and the import tool will read the data template looking for the correct formatting of a set of test data. 

Any errors will be displayed as red text. 
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Upon a successful reading of the data template, LeachXS will display a Material Data Import Options 

dialog box used to assign the data to a database. The options on this dialog box include: 

 A new, empty database 

Creates a new database and activates a dialog box for naming the database to be created 

 A copy of the current database 

Saves a backup of the current database (e.g., the database displayed) and adds the new data to 

the current database. 

 Another database 

Activates a browser window to locate an existing database, saves a backup of the selected 

database and adds the new data to the selected database. 
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At the bottom of the Material Data Import Options screen are options for opening the database after a 

successful import (i.e., make the new database the current database in LeachXS) and for saving the data 

in an XML file format. Checking the “Save intermediate XML file with material data” box will activate a 

browser window for the user to locate and name the XML file. When all desired options are complete, 

click the OK button to close the Material Data Import Options screen and initiate the Database Writer in 

the Data Import Logger window. 

 

If fields (e.g., laboratory names, material source groups, etc.) in the data template do not match the 

categories native to LeachXS, a pop-up window (e.g., see the Define Material Group window above) will 

allow the user to “map” the field to an accepted LeachXS category). Upon a successful import, the 

following box will be displayed. 

 

Click on OK, to clear the box. 

If the Open this database after a successful import check box was checked in the Material Data Import 

Options screen, the following pop-up box will be displayed. 
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Click on OK, to clear the box. 

The import process is complete and LeachXS returns to the Import or Add New Data roll-up menu. 

Filling a LEAF Template 

LeachXS provides templates for quite a number of leaching tests. The templates are installed along with 

the installation of LeachXS and are put in the location where Microsoft Excel® expects user templates. 

This is usually: 

C:\Users\<username>\AppData\Roaming\Microsoft\Templates 

Where <username> is the name you use to log on to your computer. 

You can create a new workbook from a template by starting Microsoft Excel®: 

 Navigate to File->New 

 

 Select My templates 

 

 Select the desired template and hit the OK button. 
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Classic LeachXS Modeling 

The tradition modeling efforts in LeachXS included the ability to identify likely solid phases that explain 

the pH dependence leaching data of a material through precipitation/dissolution reactions and the 

ability to incorporation solid phase dissolution with sorption phenomena to model the pH dependence 

behavior over a range of pH values. Therefore, the Classic LeachXS Modeling roll-up menu contains the 

following options: 

 Chemical Speciation Modeling 

 pH Dependence Prediction Modeling 

Chemical Speciation Modeling 

The Chemical Speciation Model is used to identify potentially relevant minerals for a material through 

calculation of Saturation Indices (SI). The result is a list of mineral phases that provide a preliminary 

description of the concentrations in the aqueous phase as a function of pH. 

Note: The calculation of saturation indices is based on total measured concentrations in solution and, 

therefore, does not take into account interactions between multiple phases, sorption to clay surfaces, or 

sorption to hydrated oxides. 

In order to start the Chemical Speciation Model, click on the Chemical Speciation (Solubility Index 

Determination) link in the Classic LeachXS Modeling roll-up menu.  

 

Select the Open icon from ribbon menu of the Case Manager tab on the top bar menu. 
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Create a Group and a Case (see “LeachXS Cases and Case Management” on page 100 for details on 

creating groups and cases). In this example, the group is named Training NIST and the case is named 

AWF and VCT). 

 

Double click on newly created case name (AWF and VCT) to start the Chemical Speciation Fingerprint 

Modeler window. 
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As a first step the information on which the model runs are based need to be loaded. 
Click on Select new material. This creates an <Undefined > <1> material in the panel Materials. 
Click on <Undefined > <1> and then click on the Concentrations Editor. 
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This opens a new window with choices where to obtain the info from. 
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The chemical speciation model mainly uses pH dependence test data, but can be used also for any other 

type of data. Here we select pH dependence test data. We choose Waste Form AWF (CBP) (P,1,1) with 

the aid of ”The Sample Selector” on page 121. After you have selected the sample and closed the 

Sample Selector, the concentrations are loaded into the editor. 

 

Hit the green button in the top left of the panel to accept the data. 
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Add an extra material by hitting New Material on the top left. This creates an <Undefined > <1> 

material in the panel Materials. 

Click on <Undefined > <1> and then click on the Concentrations Editor to select the additional material. 

Then click on From database and select the sample of interest. We pick 

Concrete VCT (vaults,CBP) (P,1,1). 

Next hit the green button on the top left of the pane to accept the selected material. 
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There are choices to be made, when the model components need to be changed, such as adding 

substances to the list of modeled elements. This will require a new Mapping of the species for the 

model (This aspect will be dealt with later). The model itself will normally not change. 

With the concentration editor modifications to the information obtained from the database can be 

made, if needed. Or additions can be made for substances not measured or substances not yet entered 

in the database. For this the concentration editor is opened by clicking Concentrations Editor. Any 

change will result in the green button, which is greyed out to turn green. 

Hit Run model to start the model run. 

Hit Save to save the choices made for this model run. 
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The model can be run either in Batch mode or Interactive mode. For this model Prepare data only is not 

so functional, unless the process of importing data and modifying the model run needs to be continued 

at a later time. 

To understand what is happening in the background it is useful to run Orchestra interactively. Hit Run to 

start the model. 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

41 

 

 

To start Orchestra by hitting Run (top left) twice (safety to avoid accidental starting of the model) 
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This screen shows the progress and the time needed for calculation. A time to go bar is shown during 

the run. To close Orchestra and return to LeachXS, hit the cross on the top right hand corner of the main 

screen. 

 

Hit Yes in the confirmation screen that pops up to close Orchestra and transfer the model output data to 

LeachXS. 
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Next the first estimate of the mineral part of the chemical speciation Fingerprint can be defined. 

Hit Fingerprint definition then select the Fingerprint editor. 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

44 

 

In opening the Fingerprint editor switch to Al+3. 
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Change the range of SI values in View. 
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Based on the SI units selections of minerals can be made by going through all elements and all possible 

mineral phases. This does require some knowledge of possible mineral phases, as some phases are 

kinetically very slow and thus do not take part in the equilibrium based modeling. Other phases are only 

formed under extreme conditions unlikely for atmosphere exposed materials. See also the note at the 

beginning of this guide. 

Selections are made by hitting the tick boxes in front of a mineral. As ettringite is described as a solid 

solution in chemical speciation modeling ettringites of Cr and other trace substances are not selected. 
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Confirm selections by hitting the green button in the top left of the pane. 
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This forms the Fingerprint definition for the subsequent modeling of pH dependence test data. In the 

top button bar, hit Case manager and then hit Save to retain the selection. 
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The results of the SI unit calculation can be viewed by hitting View results. 
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Under Species series element selections can be made with the Edit Species list editor.  
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With Add one can add a new Substances list. It is only possible to view substances that have been 

mapped in the model. To view additional substances, the list of substances must be expanded first in the 

model. 

Select a species list to View results and select a Material to view (bottom of the pane). 
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The results can be exported to Microsoft Excel® for separate data handling. 

Hit Export selection of Export all. The first will export a selection of graphs. The latter will export all 

species in the list. 
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The default name for the worksheet that is to be created is too long, so we need to change the name. 
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Hit Show to see the Microsoft Excel® workbook. 
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Under Bulk export , all selected species lists can be exported to Microsoft Excel® in one go. 
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The speciation fingerprint is used in the subsequent pH dependence test modeling.  

pH Dependent Leaching Prediction  

The pH Dependent Leaching Prediction model describes the measured leaching behavior in the pH 

dependent method 1313. The output from “Chemical Speciation Modeling” on page 33 is used to 

describe the leaching behavior as a function of pH. 
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Click on pH Dependent Leaching Prediction to start the Model run. 

 

 

Click Open to create a Group (here Training NIST) and a Case (AWF and VCT). See “LeachXS Cases and 

Case Management” on page 100 for details on how to do this. 
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Double click on the created case (AWF and VCT) to start the model preparation. 

 

As a first step the information on which the model run is based needs to be loaded. This relates for this 

model to element Availabilities, Minerals and Model parameters. 

To fill the availabilities table either select From other case or From Database…. Click on From 

Database… to select the material to be modeled (here Analogous Waste form). 

The Sample Selector appears. Select sample Analogous Waste Form AWF. For details on how to use the 

Sample Selector, see “The Sample Selector” on page 121. 
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The composition taken from the database can be adjusted, if needed with the Availability editor. 

The next step is to include a mineral selection by clicking on Minerals. The minerals can be selected 

from a few different locations: 

 By Load…. The Case Manager is shown with groups of mineral sets. If you have saved mineral 

sets, they will show up here.  

 From a Speciation Object , such as the one described in “Chemical Speciation Modeling” on 

page 33. 

 From Other Case… The Case Manager is shown with groups of pH Predicton cases. If you have 

saved pH Predicton case, they will show up here. The mineral set in the selected case is 

extracted and put in the current case. 

The Mineral list can be displayed in two modes: No grouping (alphabetical) and grouping By Species. 

Here we select the second option: From a Speciation Object.  

Select case Training NIST from the Speciation case manager. Then select AWF and VCT. A message will 

pop up: 
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This option gives the possibility to edit the mineral selection. Let’s accept the selection by clicking No. 

The mineral sets can be shown in alphabetical order and by Species (See below). 
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The next step is to incorporate the Model parameters into the run. 
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The default values for clay, hydrated iron oxide and total organic carbon can be modified with actual 

measurements of these parameters (ISO standard 21268 parts 1-5). 

The pe+pH is a measure for the redox state of the material. A value as low as 4 – 6 reflects reducing 

conditions. A pH+pe of 8 – 10 indicates mildly reducing conditions. While oxidized conditions prevail for 

pe + pH > 13. 

Organic matter is special as there is both dissolved and particulate organic matter. Several metals and 

radionuclides have a high affinity for organic matter surfaces. Association with dissolved organic matter 

will increase the mobility of otherwise immobile substances. In DOC complex forms metal are less toxic 

to organisms, as they cannot release the substance from the organic matter. As organic matter 

degrades, it will produce dissolved organic matter. Organic matter is present everywhere and thus its 

role cannot be ignored. The organic matter allows distinguishing between different forms of organic 

matter and reactive fractions thereof. 

Default values for organic matter and its distribution can be provided at a later stage for use in concrete 

and waste form studies. 

Here the base organic matter info is taken from the source material (measured DOC or TOC in eluates of 

the pH dependence test) 
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The Organic matter editor allows you to define the reactive fraction of DOC for interaction with trace 

components. As a default value, 20 % can be used, when no data on the actual distribution are available. 

 

By clicking on View it is possible to toggle between absolute and percent values. It is easier to work with 

percent values. 
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By hitting the green button at the top left, the settings are saved in the case. Sometimes an error 

message occurs. Ignore this and save again. 

 

The L/S (liquid to solid ratio (L/kg) to be used is given by the pH dependence test as 10. It is possible to 

run a low L/S in parallel to the L/S=10 condition to assess to what extent the model result at L/S=10 

adequately described the release at low L/S. This condition can be selected by hitting the tick mark at 
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Second iteration. If this condition is selected a Second iteration material needs to be selected. For this 

material the L/S to reflect porewater needs to be selected. Generally a value of 0.2 - 0.3 is adequate. 

Hit the Select… button in tab group Second iteration material. The Sample Selector will show up. 

Choose the percolation test of sample Analogous Waste Form Awf CBP (C,1,1). 

 

Before the run is actually started, it is good to check that all species in the model are adequately 

mapped. This is done by hitting Species-Constituent mapping. 
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Hit Species mapping editor to verify that all species are mapped adequately. If not, they won’t be part 

of the modeling run. 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

67 

 

To map TIC on carbonate: click on H2CO3 and double click on TIC. 
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Hit the green button at the top left of the pane. 

The settings can now be saved by clicking on the Save button at the Case Manager level (top bar). 

Now all is set to run the model. Click Run model. 
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The model can be run either in Batch mode or Interactive mode. For this model Prepare data only is not 

so functional, unless the process of importing data and modifying the model run needs to be continued 

at a later time. 

To understand what is happening in the background it is useful to run Orchestra interactively. Hit Run to 

start the model. 
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A progress bar will show up, indicating the progress of the model calculations. A log of actions that are 

taken during calculations is shown as well: 

 

To close Orchestra and return to LeachXS, hit the cross on the top right hand corner of the main 

window. Conformation will be asked: 

 

Hit Yes in the confirmation screen that pops up to close Orchestra and transfer the model output data to 

LeachXS. 

Hit Save to save the results of the run. Hit View to visualize the model results. 
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Tick Show graphs to view the results of General parameters, By species series or By Individual species 

respectively. 

Here are examples of the various views. 
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The red dots are the pH dependent leaching test data (Method 1313). The blue dots are the percolation 

test data (Method 1314). If the data overlap, the conclusion is that the substance is solubility controlled 

and pH and redox are more important controlling factors of release than L/S (liquid to solid ratio). 

This is a very crucial observation for long term prediction potential. 
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In an iterative approach the description can be optimized to describe all major, minor and trace 

substances in an optimized condition.  

An optimized fit is shown for AWF (Waste form) below and will be made available at the training, as well 

as optimized model runs for all other CBP materials. 
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From these further modifications can be modeled, such as imposed reducing conditions, carbonation, 

addition of radionuclides, change in model parameters like HFO (hydrated iron-oxide content, variations 

in organic matter content, changes in trace element content, etcetera. 

The pH dependence test modeling in combination with the percolation test covers a wide range of pH 

and L/S conditions and results in a Chemical Speciation Fingerprint (CSF) that can be used as basis for 

subsequent modeling of mass transfer cases. 

The CSF consists of element availabilities, reactive surface quantification (clay, Iron oxides, and organic 

matter), minerals and redox status. 

Tank Model 

(No description available yet…) 
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Advanced Modeling 

The most advanced models that are disclosed in LeachXS are displayed in the Advanced Modeling roll-up 

menu. In particular, all models that are developed in the Cementitious Barriers project can be found 

here. 

 

Cementitious Barriers Modeling Scenarios … 

The development of scenarios for the Cementitious Barriers Partnership (CBP) follows the following 

general path: 

 Within ORCHESTRA, a conceptual model is developed to describe sub-scenarios for CBP-relevant 

problems in HLW tank closure, waste vault disposal, spent fuel pool storage, and D&D activities. 

 After preliminary testing, the model is implemented in LeachXS to allow easy data input 

preparation and output handling in graphical tabular and export mode. 

The family of CBP models is accessed through the Cementitious Barriers Modeling Scenarios … link. 
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If you click on one of the available scenarios, a schematic diagram of the selected scenario will appear in 

the top right pane. In the example above, the Monolith Diffusion Test Scenario has been clicked. You 

can adjust the size of the window. You can also enlarge or reduce the size of every pane by dragging its 

border up, down, left or right. 

The models that have been developed are categorized in: 

 Lab test simulations 

The currently implemented scenarios are: 
o Monolithic Diffusion Test Scenario 

Simulates tank test leaching results 

o Percolation Column Test (mobile-immobile zones) 
Simulates column test results considering a dual regime equilibrium/convection approach 

 Prediction scenarios for monolithic diffusion 

Simulates leaching from single systems of containing monolithic materials with options for 

physical/chemical degradation from: 

o Leaching (1 Layer) 

o Sulfate Attack with Leaching (1 Layer) 

The sulfate attack model is a model developed for the CBP to address degradation of the 

cement barrier by elevated sulfate levels in contact with the barrier either from within or 

outside the barrier. The subject has been one of the subjects worked out by Sohini Sarkar 
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for her Thesis at VU. It is one of a series of sub-models to be implemented in LeachXS to be 

used through the GoldSim Bridge in GoldSim simulations. 

o Leaching with Carbonation and Oxidation (1 Layer) 

 Prediction scenarios for percolation 

The currently implemented scenarios are: 
o Mobile-immobile Zones Dual Regime Leaching 
o Percolation with Radial Diffusion Leaching 

 

To begin the sulfate attack modeling process, highlight a sulfate attack modeling the Available Scenarios 

pane and click on Start Modeling. 

 

The CBP Scenario Editor will show up. The editor will assist you in: 

 Editing input data for a model; 

 Running the model; 

 Showing model results; 

 Saving your work; 

 Opening previously saved sessions. 

Click Start Modeling to begin 
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The CBP Scenario Editor 

The CBP Scenario Editor is a framework for working with CBP scenarios. It designed to have a consistent 

look and feel for all CBP models, although some parts of the editor may not be available for a specific 

model. For instance, the option to select a monolithic lab test that is to be simulated will only be 

available for a lab test simulation model and not in any prediction scenario for monolithic materials. 

Below is an overview of all the elements that are part of the editor. 

 

The description below summarizes the main functions of the editor. In order to see all options that are 

described, check the box Show Advanced Options on ribbon tab View in the ribbon bar. 

Scenario Editor components 

Navigation pane 

This pane is used to navigate through all information of the model that can be edited or shown. It will 

also assist you in running the model and showing results. The pane is divided in four sections, grouping 

Ribbon bar 

Components 

pane 

Parameters 

pane 

Navigation 

pane 

Ribbon tab, 

groups and 

functions 

Application 

button 
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similar aspects of the model together. You can expand a section by clicking on its header. If you do so, 

the clicked section will expand itself, while other sections are collapsed. 

Section Model Input shows all building blocks of the model and the input data associated with them. 

Every phrase in the section is a link. Clicking it will reveal the data associated with it. 

Section Model Components shows configuration data for the model: the files that comprise the entire 

model, the Orchestra files needed to run a model and more. You’ll probably won’t visit this section, 

unless you are an advanced user. 

Section Run contains options to run the model. 

Section Model Results will enable you to make selections in the model results to be displayed and 

reported. 

Components pane 

The model picture pane shows the same schematic picture of the model as the one that was displayed 

in the Model Chooser. It can be used as an alternative to navigate through the scenario components. If 

the Model Input panel or Model Results panel is expanded, clicking on a segment of the picture will 

select the corresponding scenario component in the panel. 

Parameters pane 

The content of this pane depends on what section of the navigation pane is selected. When the Model 

Input section is expanded, a description of the selected entry is shown. If you have checked the box 

Show Advanced Options on ribbon tab View in the ribbon bar, you’ll see that part of the Orchestra 

input file that contains input data for the selected entry. When the Model Components section is 

expanded, you’ll see details of the specific model component you have selected. When the Run section 

is expanded and the model is running, you’ll see details about the progress of the run. When the Model 

Results section is expanded, it will contain options to specify what results are to be shown. 

Ribbon bar and its elements 

The ribbon bar contains all functions you can use to manage your model input and show results and 

reports. All functions are organized in different ribbon tabs. Within a ribbon tabs, ribbon groups are 

used to group functions that belong logically together. 

Application button 

Clicking on the application button will reveal two lists. The left list contain general functions that are 

applicable to many windows and the right list contains the most recent cases that you have used for the 

particular type of model you are working with. 
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Organizing your work 

The CBP Scenario Editor offers you facilities to save all changes you made. All input data, model files and 

model components like minerals and Orchestra files are bundled into one document called a Case. Cases 

can be saved for later use and opened again. The ribbon tab group Case Manager gives access to the 

LeachXS Case Manager, which helps you saving and opening cases. You can read more about cases and 

the Case Manager in chapter “LeachXS Cases and Case Management” on page 100. 

Every CBP model contains a number of cases that you can use as a template. Use the Open… button on 

the ribbon tab Case Manager to select a template. After you have opened a template, the case is loaded 

into the editor. The same ribbon tab contains functions to save your edits. 

Reporting and documenting 

You can make a report of your case by pressing the Report button on ribbon tab Case Manager. The 

following dialog will show up: 

 

The report will be created in a Microsoft Excel® workbook and worksheet of your choice. Use the Open… 

or Create… button to open an existing workbook or create a new one. The left pane shows the proposed 

worksheet name to create the report on. You can choose another name by double-clicking it. The right 

pane shows the worksheets that your chosen workbook contains. Press the Generate button to create 

the report. You can inspect the destination workbook by hitting the View button. 

You can attach documents to your case for reference or documentation. Press the Attached Documents 

button on the Case Manager ribbon tab to organize your attachments with the Attached Documents 

Manager. 
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The pane named Current Attachments shows a list of attachments that are already included in your 

case. Use the Add File… button to add additional documents. Alternatively, you can drag files from an 

explorer window onto the Current Attachments pane. You remove documents by selecting them and 

press the Delete button. Press the Show Contents button to inspect a document you have selected. If 

you want to edit an attached document, use the Save button to save a copy of the attachment to the 

location that is listed in the Original Location column. Alternatively, you can use the Save As… button to 

specify a different location. After editing the document, drag it to the pane or use the Add File… button. 

Note that the document will be added to the list. You should remove the original file by selecting it and 

pressing the Delete button. 

Note that your attachments are not linked to your case. They are actually copied into it. 

Navigation pane: Model Input 

The Model Input section displays the Orchestra input file in a structured manner. This file (which is 

typically named leachxs_parameters.txt) is formatted and organized in blocks in such a way, that both 

LeachXS and Orchestra can interpret it. All blocks in the input file are organized in the following 

categories: 

 Scenario Components. 
The blocks in this category correspond with the segments in the graphical representation of the 
modeled case. For the chosen model, the segments are the Cement barrier, the Inflow solution and 
the Outflow. The data for every segment may be organized in separate blocks, such as physical 
parameters, chemical parameters or output parameters. Other blocks may be present, depending 
on the model. Chemical data is usually composed of concentrations or availabilities. Other non-
chemical parameters are collected in the physical data block. Output parameters usually denote 
time series with times the model outputs results. 

 Other Components. 
The blocks in this category are segments that play a role in the model, but are not represented in 
the graphical representation of the model. 
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 Other Parameters. 
This category may contain blocks containing parameters that do not belong to a particular segment 
or component, but are parameters to the model as a whole. 

 Parameter Mapping. 
It may not be desirable to represent model parameters with the name and unit of measurement 
that Orchestra uses. The parameter mapping block contains a list of these variables, together with a 
corresponding LeachXS name, unit of measurement and a conversion factor to convert an Orchestra 
variable to a LeachXS variable. Note that this list usually is composed in the design phase of the 
Orchestra model and need not be modified. 

 Other Classes. 
This category contains all blocks in the input file that do not belong to any of the other categories. 

Every data type in this section has a dedicated editor. Chemical and physical data can be edited with the 

Model Data Editor, refresh data with the Refresh Editor and output data with the Output Times Editor. 

Navigation pane: Model Components 

 

The Model Components section shows parts of the heart of the model and some interface definitions 

between Orchestra and LeachXS. These parts are usually not of interest or importance to a regular end 

user. The categories to edit offered here are: 

 Model to use 
The Orchestra model is composed of a number of files that define relevant parameters, chemistry 
and definitions. These files together are called the “model”. Files in the model can be edited, 
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replaced or removed, and extra files can be added. This function is normally of importance for a 
model designer only. 

 Orchestra System 
The Orchestra system is a set of files that form the heart of the Orchestra engine that is capable of 
performing the instructions that are comprised in a model [a better description needed]. Files can 
be added, replaced or removed, and extra files can be added. This function is normally of 
importance for a model designer only. 

 Species-to-Constituents Mapping 
Some model parameters, like concentrations and availabilities, can be obtained from a LeachXS 
database with leaching data. The name giving of constituents like Na, As or Ba is different from the 
entities in Orchestra. The Species-to-Constituents Mapping defines which Orchestra species 
corresponds to which LeachXS constituent. This function is normally of importance for a model 
designer only. 

 Minerals 
Mineral reactions play an imported role in many models. The set of minerals that take part in the 
model can be defined and edited here. 

The first two items will be visible only if the box Show Advanced Options on ribbon tab View in the 

ribbon bar is checked. 

Navigation pane: Run 

 

The Run section shows the different ways to run the model. Currently, the options are: 

 Interactive Mode 
Clicking this link will start Orchestra in interactive mode. Orchestra is started and execution is 
suspended until the Run button is clicked in the Orchestra user interface. 
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 Batch Mode 
Clicking this link will start Orchestra in batch mode. Orchestra is started for immediate execution. No 
user interface will show up. 

 Prepare Data Only 
Clicking this link will not start Orchestra, but instead, a directory is created and all model files and 
Orchestra system files are stored in an appropriate directory structure, fit for running Orchestra 
outside of the LeachXS environment. This function is normally of importance for a model designer 
only. 

The first and last option is visible only if the box Show Advanced Options on ribbon tab View in the 

ribbon bar is checked. 

Navigation pane: Model Results 

 

The Model Results section helps you to select the results you want to inspect. It shows all scenario 

components and reveals what results can be obtained after selecting a specific scenario component. 

Editing your scenario 

The Edit tab of the ribbon bar contains all functions to edit your scenario. What functions are available 

depends on what part of your model is selected. If you have selected anything in the Model Input 

section in the navigation pane, the tab may show something like this: 
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Tab group Model Source Material will only be present if you have opened a scenario for simulating a lab 

test. By pressing the Select… button you can select an existing lab test. The geometry and other physical 

parameters of the model will be set to the geometry and physical parameters of your selected test. 

You can define standard solutions that can be used by your model. Press the Modify… button on the 

Available Solutions ribbon tab to define them. If, for example you are editing a model that simulates a 

monolithic diffusion test, you can use the solutions you have defined here for refreshing the tank. 

You can edit a specific part of your scenario data by using the LeachXS Editor button on the Editor tab 

group. This will start an editor that is designed for the part of your scenario you selected. 

The Data Editor 

The Data Editor is designed to edit chemical or physical data. For instance, if you select any entry with 

chemical parameters in the Model Input section of the Navigation pane, the editor may show up like 

this: 

 

The editor may show several sections, depending on the content of the chemical parameters. These are 

the sections: 

 Solid Constituents 

All constituents that are defined in the solid phase of the chemical parameter block are shown, 

together with their values, in mg/kg. There may be several rows of values, depending on how the 

block of chemical parameters is modeled. You can edit every single cell that represents a 

concentration. You can also obtain concentrations or availabilities for certain cells from the LeachXS 
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database. First, select the cells you want to fill from the database. You can select a range of cells, an 

entire row (click on the row header) or the entire grid (click the top left cell in the grid). Next, click 

tab Chemical Data and the Availability or Total Content… button on the From Database tab group. 

Next, select a test from the database: the selected cells will be filled from the selected test. 

Note: if there are constituents in your selection that did not have any availability data, the editor will 

inform you about the constituents that were not found in the database before the found constituents are 

filled. After you have acknowledged the message, the values of the constituents that were found in the 

database are updated and colored blue. The other values will not be updated and retain their black color. 

 Dissolved Constituents 
All species that are defined in the gas phase of the chemical parameter block are shown, together 
with their values; in mg/L. Edit them as desired. 

 Gas Constituents 
All species that are defined in the gas phase of the chemical parameter block are shown, together 
with their values, in volume percentages. Edit them as desired. 

 Additional Specifications 
All other, non-concentration variables in the parameter block are shown here. Edit them as desired. 

When you are finished, press the green checkmark in the title bar to save your changes. LeachXS will 

rewrite the input file for the model. You should be aware of the fact that any previously generated 

model results will become invalid. 

The Refresh Scheme Editor 

The Refresh Scheme Editor is designed to edit refresh data. For instance, if you select any entry with 

refresh parameters in the Model Input section of the Navigation pane, the editor may show up like this: 

 

The grid below the ribbon bar shows all the information needed to define the refresh steps. The pane at 

the very bottom of the window shows an impression of the relative lengths of each step. Clicking on a 

segment of this pane will select the corresponding step in the grid. 
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Edit functions 

If you double-click on a value in one of the columns Duration, Volume or Flowrate, you can alter its 

value. 

The From Database… function on the Fetch Scheme tab group lets you pick a test material, whose 

refresh scheme will replace the current one. 

The Define Range… function on the same tab group gives you the option of quickly generate a list of 

times. You can define a list of evenly distributed time steps, a list of times where each successive time 

increases with a constant factor, or just a list of times at you liking by typing a space separated list of 

times. See “List Generator” on page 147 for details. 

With the functions on the Add/Remove steps tab group, you can add or insert a step or remove 

selected or all steps. 

You can change the order of the steps by using the Move Up and Move Down buttons in the Move 

Steps tab group. 

You can undo all your actions and revert to the list as it was when starting the editor by pressing the 

Undo All button. 

View functions 

You can change the time unit by clicking the appropriate button on the View tab. 

The Output Times Editor 

The Output Times Editor assists you in editing the times model results are recorded. You can use this 

editor if you have selected Output parameters in the Model Input panel. 
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The title bar contains buttons to close the editor and save (green button) or abandon (red button) 

changes. The text in the bar indicates if you have changed any data or not. 

The ribbon bar contains functions to edit the times (the Edit tab) and to alter the way the data is 

displayed (the View tab). 

The grid below the ribbon bar contains the list of times. Apart from the functions on the Edit tab, you 

can alter a time by double-clicking on the entry you want to change. 

The bar at the bottom of the window gives you an indication of the relative lengths of the times in the 

list. 

Edit functions 

If you double-click on a time step in the list, you can alter its value. Note that the list will be sorted 

immediately after you have changed it, so that the steps are in ascending order. 

The Default Times function on the New List tab group replaces the current list with the list of times that 

might be appropriate for the model. 

The Define Range… function on the same tab group gives you the option of quickly generate a list of 

times. You can define a list of evenly distributed time steps, a list of times where each successive time 

increases with a constant factor, or just a list of times at you liking by typing a space separated list of 

times. See “List Generator” on page 147 for details. 

With the functions on the Add/Remove steps tab group, you can add a step or remove selected or all 

steps. 

You can undo all your actions and revert to the list as it was when starting the editor by pressing the 

Undo All button. 

View functions 

You can change the time unit by clicking the appropriate button on the View tab. 

The Model Files Editor 

If you have selected the Model to use section of the Model Components navigation pane, you will be 

able to modify the set of files that comprise the model you chose. You can add, edit view and delete files 

from the model and you can set the amount of memory the model is allowed to use. 

Note that this is possible only if the box Show Advanced Options on ribbon tab View in the ribbon bar is 

checked. 
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The title bar contains buttons to close the editor and save (green button) or abandon (red button) any 

changes. 

The ribbon bar contains functions to add files to or remove files from the file list (the Contents tab 

group) and to view or edit a selected model file (Edit or Inspect tab). You can also save the model as a 

separate object for use in other model cases or load one from disk. These functions are present in the 

Case Manager ribbon tab. Note that you can also add files by dragging files from any Windows Explorer 

window and drop them on the file list. 

The pane below the ribbon bar shows the amount of memory the model is allowed to use and a model 

description. You can edit both the memory and the description. 

The bottom pane shows the list of files make up the model. The files that form the core of the model are 

colored blue. 

The Orchestra System Editor 

If you have selected the Orchestra System section of the Model Components navigation pane, you will 

be able to modify the set of files comprising the Orchestra system that is included with your case. 
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Note that this is possible only if the box Show Advanced Options on ribbon tab View in the ribbon bar is 

checked. 

 

Most functions of this editor are the same as the ones in “The Model Files Editor” on page 91. In 

addition, you can specify the Orchestra jar file this is to be executed for running a model and how the 

Java executable is called in your system. 

The Species Mapping Editor 

Orchestra uses species in its chemistry, whereas LeachXS uses constituents. When assigning 

concentrations or availabilities to Orchestra species, a LeachXS database can be used as source. In order 

to assign values to species correctly, a mapping should exist that maps an Orchestra species to a 

LeachXS constituent. 

If you have selected the Species-Constituent Mapping section of the Model Components navigation 

pane, you will be able to modify this mapping by pressing the LeachXS Editor button on the Edit tab of 

the ribbon. 

The Species Mapping Editor lets you inspect or adjust the mapping of all species of the model you use to 

constituents. You can assign one or more constituents to a species. If you assign more than one 

constituent, the order of constituents is of importance. When assigning a concentration from a LeachXS 

database to a species, LeachXS will walk through the list of assigned constituents. The first constituent in 

the list that has a concentration will be used. 
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The title bar contains buttons to close the editor and save (green button) or abandon (red button) 

changes. 

The ribbon bar contains functions to edit the mapping (the Edit tab group), to group species (the View 

tab group) and to save or load existing mapping definitions to or from disk (the Case Manager tab 

group). 

The left pane below the ribbon bar (Species pane) shows the mapping of all species, whereas the right 

pane (Available Constituents pane) contains all available LeachXS constituents you can use for mapping. 

The bottom pane (Mapped Constituents pane) shows the constituents that are mapped to the species 

that is selected in the left pane. 

To assign one or more constituents to a species, first select a species in the Species pane. Then, look up 

an appropriate constituent in the Available Constituent pane and double-click it. The constituent will be 

added to the list of mapped constituents in the Mapped Constituents pane. 

To remove a mapped constituent, first select the species containing the constituent to remove. Then 

select the constituent in the Mapped Constituents pane and click on the Delete button in the Edit tab, 

tab group Constituent. 
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If you want to change the order the constituents are mapped for a species that is mapped to several 

constituents, select the subject species, then select a constituent in the Mapped Constituents pane and 

use one of the buttons in the Constituent tab group to change the priority of the constituent. 

While manipulating the entire mapping, it may be handy if species are grouped according to their 

mapping. The Species grouping buttons on the View tab let you group or ungroup the list of species. 

The Minerals Editor 

Minerals play an important role in the modeling process. You can change the list of minerals that are 

used in the model with the Minerals Editor. Select the Minerals section of the Model Components 

navigation pane, and press the LeachXS Editor button on the Edit tab of the ribbon. The Minerals Editor 

will appear. 

To ease the process of selecting appropriate minerals, the editor contains two lists. One list contains all 

the minerals that comprise the selection you want. The other list contains a pool of minerals. You can 

load minerals from a mineral source to this pool. From the pool, you can compare mineral definitions 

with definitions in the list of selected minerals. You can also drag minerals from the pool to the selected 

minerals list. 

 

The title bar contains buttons to close the editor and save (green button) or abandon (red button) 

changes. 
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The ribbon bar contains functions to fill the pool (Mineral Pool tab), edit the list of selected minerals 

(Mineral Selection tab), change the layout of the mineral lists that are displayed (View tab) and save 

your selection to disk (Case Manager tab). 

Below the ribbon bar are three panes. The left pane (Valid Reactants) shows all the species in your 

model. The left pane shows the minerals that play a part in the model (Selected Minerals). The middle 

pane contains the minerals in the pool you have opened (Pool of Available Minerals). 

Using the Mineral Pool 

If you want to add minerals to your selection, you’ll need the Mineral Pool. Once the pool is filled, you 

can start adding minerals. You can fill the pool from various sources. If you already have saved lists of 

minerals to disk, use button Existing Mineral Pool… from the Load group of ribbon tab Mineral Pool. 

Alternatively, you can select a Chemical Speciation Case you have created previously and use the 

minerals in it. Use button From Chemical Speciation Case… from the same tab group to select the case. 

Finally, you can use text files containing mineral definitions. The format of these files must be equal to 

the ones that are used to define the minerals of the Orchestra system. 

Organizing the minerals 

A number of view options are available to control how and which minerals are displayed in the pool and 

the list of selected minerals. The options are situated in tab View of the ribbon bar. You can display the 

minerals grouped by reactant or species. Press By Reactant of the Grouping tab group to group them. 

Note that the lists will grow considerably, because a certain mineral will show up in every reactant that 

has part in the mineral reaction. 

When grouped by reactant, you can use the Valid Reactants pane to jump to the list of minerals having 

a certain reactant. If you select a reactant in this pane, the mineral lists are repositioned to show the 

minerals containing that reactant. 

You can control the visibility of minerals that contain reactants that are not in the list of valid reactants. 

The tab group Show Minerals Having Reactants… you can choose: 

All All minerals are shown; minerals having at least one reactant 
that is not in the list of valid reactants are colored red. 

Having Any Available Reactant A mineral is shown only if it has at least one of its reactants is 
in the list of available reactants. Again, minerals having at 
least one reactant that is not in the list of valid reactants are 
colored red. 

Having Available Reactants Only A mineral is shown only if all of its reactants are present in the 
list of available reactants. No minerals are colored red. 
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Editing the list of selected minerals 

Add minerals to your set by dragging selected minerals in the pool over the Selected Minerals pane and 

release them there. Alternatively, you can use Add To Selected on the Edit tab group of tab Mineral 

Pool. Pressing this button will copy selected minerals in the pool to your mineral set. 

Added minerals from the pool are in no way connected to the pool anymore; you can fill the pool from 

another source and add minerals from that source as well, without losing added minerals from another 

pool. 

Take care with dragging minerals from the pool to your set: if a mineral in the set has the same name as 

one in the drag list, it will not be replaced, even if the reaction definition is different. 

Remove minerals from your set by selecting the minerals to remove and pressing Delete from the Edit 

group of the Mineral Selection tab. Press Clear from this group to empty your set and Undo All Changes 

to restore the set to what is was when you opened the editor. 

Note that there is no way of adding a mineral by directly typing a mineral reaction. Instead, create a text 

file, type your reaction in the format equal to the format that is used to define the minerals of the 

Orchestra system. Then, open this file in the mineral pool and drag the mineral(s) to the set of selected 

minerals. 

The Species List Editor 

If you want to see results of model calculations, you can select constituents by marking the checkboxes 

in front of the constituents that are present in tab Species of the Parameters pane if Model Results are 

visible in the Navigation pane. Alternatively, you can make predefined lists of species and select one to 

show results for all species in the list. Predefined species lists appear in tab Species List, next to the 

Species tab. To create, modify, load and save lists of species, use the Edit… button on ribbon tab Results 

and Reports. The Species List Editor will appear. 
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The left pane contains the species lists. The right pane contains the species that make up the list that is 

selected in the left pane. The List ribbon tab contains two fields. If you want to add a new list, type a 

name for the list in the Add field and hit the Enter key. If you want to give a list a new name, select it, 

type a new name in the Rename field and hit the Enter key. 

You can add or remove species to or from a list by selecting the list and click in the Species of series 

pane. The Species ribbon tab will be activated. 

 

To add a species, select one from the Add list. To delete species, select them and press the Delete 

button. 

You can save the set of lists to disk and save them for use at some other place or load an existing set. 

Select the Manager tab and press the Save or Save As… button to save the set or use the Open… button 

to load an existing one. The Case Manager will show up. See “LeachXS Cases and Case Management” on 

page 100 for details. 

Editing with a text editor 

As an alternative to a dedicated data editor, you can edit data in your favorite text editor. The data will 

be presented in text, just as it is defined in the leachxs_parameters file. Only items in the Model 

Input navigation pane can be edited with a text editor. Note that this is possible only if the box Show 

Advanced Options on ribbon tab View in the ribbon bar is checked. 

Before you can use it, you’ll need to make it accessible from within LeachXS. Press button Customize 

Editor… from the Editor tab group of tab Edit. The following small dialog pops up: 
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Press the Add… button and browse to the editor you want to use as text editor. In the above example, 

we’ve selected two editors as text editor: Notepad and Microsoft Excel®. Click on Notepad and press 

Set As Default to make Notepad your default text editor. 

LeachXS will remember the editors you’ve selected to be candidates for a text editor, as well as the 

editor you have designated to be the default text editor. 

This is what LeachXS will do if you want to edit a block of data with the text editor of your choice: 

1. It will create a temporary file containing the data and remember the file size and time of creation. 
2. It will start your editor with the file specification of the temporary file as argument. 
3. It will wait until the editor is closed. 
4. It will examine the file size and last modified time of the temporary file. If it is different with respect to the 

remembered size or time, it assumes the contents have been changed, and the subject block of data is 
replaced with the data in the temporary file. 

5. It will dispose the temporary file. 
Note that some editors might behave not quite as expected if they are closed while the file contents is edited. 

If, for instance, Microsoft Excel® is used to edit a file, closing Microsoft Excel® causes the following message to 

appear: 

 

When the Save button is pressed, Microsoft Excel® forces you to give a different file extension for the file to 

save. In that case LeachXS does not detect any changes. For Microsoft Excel®, the appropriate action to take 

for saving edited data is: 

Press File->Save, and answer Yes to the appearing question. Next, close Microsoft Excel® and answer Don’t 

Save to the appearing question. 

For other editors with an analogous behavior, you’ll need to sort out the correct way to exit the editor 

yourself. 
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LeachXS Cases and Case Management 

LeachXS allows the user to save any combination of selected materials and model outputs as a Case (i.e., 

a collection of files that may be recalled from a user-defined storage folder for later use or shared 

between users using the export/import features). Cases are saved in LeachXS using a browser window 

that allows access to the Map Store-Group-Case data structure. Map Stores and Groups are simply 

folders that allow the user to categorize their output and for LeachXS to recognize the saved data. 

Saving a Case 

To save the current case, click on the Case Manager tab on the top menu and select the Save As icon in 

the ribbon menu. 

 

This action opens a pop-up window for storing user-defined items in LeachXS using the Map Store 

object. The tree structure in the upper left corner shows the currently defined map stores while the 

window on the upper right shows the current object within a highlighted map store. A Map Store file for 

LeachXS User Objects exists by default. 
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Creating a New Map Store Folder 

If no user-defined map store has been created for saving cases, create a new map store by clicking on 

New icon on the ribbon menu under the Map Store menu tab. Use the pop-up browser window to 

create a new folder by clicking the Make New Folder button and providing a name for the map store. 

Click the OK button to save the map store and display it in the tree structure. 

 

#2 Create and 
name a new folder

#3 Finalize

#1 Select “New” to 
open browser window
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Create a Group within a Map Store 

Highlight the Map Store where cases are to be saved and then select the Group menu from the top 

menu bar. Create a new group by entering a folder name in the New field and pressing the Enter key on 

the keyboard. 

 

Creating a Case within a Group 

Highlight the group name in the left window to activate the Case menu tab on the menu bar. Create a 

case within the selected group by entering a case name in the New field and pressing the Enter key on 

the keyboard. 
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These actions results in the following window. 

 

Loading a Case from the Map Store 

To recall a case from the map store into a comparison window, click on the Case Manager tab in the top 

menu bar and select the Open icon from the ribbon menu. 

#1 Highlight group

#2 Open “Case” 
menu ribbon

#3 Type name for the 
case and press “Enter”
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Use the tree structure to navigate to the target group and highlight the group name in the left hand box. 

Highlight the desired case in the right hand box and click on the Open icon in the ribbon menu of the 

Case menu tab.  

 

#1 Highlight group

#2 Highlight case

#3 Open “Case” 
menu ribbon

#4 Click on the “Open” icon
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Exporting a Case 

If you want to share or hand over a case to another user, you can export a case. The other user can use 

the import function to add the case to his system. Any object type that is managed by the Case Manager 

can be exported. To export a modeling case, a comparison or any other object, open the Case Manager 

from the editor context of the object you want to export. For example, if you want to export a Granular 

Materials Comparison case, open the Granular Materials Comparison window from the main window 

of LeachXS and hit the Open button. Select the case you want to export and hit the Export… button. 

 

The object to be exported will be packed into a zip file. A dialog will appear to enable you to specify a 

location and name for the zip file that will contain the object. Hit the Save button to save the zip file. 

 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

106 

Note: you can export more cases at a time by selecting a group or by selecting multiple objects within a 

group. All selected objects will be included in the zip file. 

Importing a case 

If you have received a zip file containing a case or object, you can import them in your own system. The 

import function is located in the ribbon bar of the main LeachXS window, in tab Tools: Case Importer. 

 

Click on this button. The Case Importer will show up. Press the Select… button to navigate to the zip file 

containing the case to be imported. The Case Importer will indicate what type of case the zip file 

contains. Hit the Import button to import the case into your own system. 
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Using a Zip Store to Compress Files 

In a similar manner as the Map Store, a Zip Store needs to be created with the cases to be exported. A 

Zip Store is a folder where compressed or zipped files are stored. To create a new Zip Store, select All 

Stores in the list of Stores and Groups pane and click on the Zip Store tab in the top menu bar to 

activate the Zip Store ribbon menu. 

 

Click on the New… icon from the Zip Store ribbon menu and select the location where the zip file should 

be stored (e.g., the computer Desktop or a user file). Selecting the Make a New Folder button will 

create a folder for the new Zip Store. Click the OK button to finalize creation of the Zip Store. 
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In the example below, a new Zip Store has been created and automatically named New pH PredictCase 

Zip store. The file can be renamed as desired; however, it is important that the case creator and the 

recipient of the case file know to what type of model the case belongs, as this is important for importing 

the case file in the proper model editor. 

 

Navigate to the Map Store and select group Export from the Groups of the Map Store pane. Drag the 

group Export to the Zip Store titled New pH PredictCase Zip store to move the case to the Zip Store 

folder. 
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The newly-created Zip Store now contains the Export group from the Map Store. 

 

The zip file in the Zip Store folder can be sent to another LeachXS user. Since all model components are 

embedded in the case this ensures that the other party has the exact same model and underlying 

settings and input data as the primary user. 

The Model editor can be closed. Ignore the message and click Yes. 

Drag case name to move 
“Export” case Zip Store
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The created zip store will disappear (or can be deleted) as soon as the zip file has been sent to the 

receiving user, moved to another location, or renamed. 

Note: It is not possible to mix case files from different models within one zip file. This is because LeachXS 

will not be able to recognize the model when placed in the wrong model editor. 
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Statistical Evaluation of Data 

Statistics functions embedded in LeachXS allow for calculation and display of statistical representations 

for multiple selected data series at critical points in the data set. 

Statistical functions allow for calculation of: 

 Mean 

 Confidence intervals 

 Prediction intervals 

 Median 

 Percentiles 

In many cases, calculation of statistics based on multiple testing results requires data 

interpolation/extrapolation to a consistent set of ordinate (x-axis) values. For example, the mean 

concentration of 3 pH-dependent replicate data series may be calculated at the target pH values. 

LeachXS offers several interpolation options (e.g., linear, spline, nearest value) that can be applied either 

directly to data sets or to log-transformed data. 

There are two pathways for carrying out statistical analyses: 

 From the Analysis and Presentation screen 

 From the Import or Add New Data roll-up menu in the main screen 

Statistical Calculations from the Analysis and Presentation Screen 

From the either of the Analysis and Presentation screens (either for Granular Materials Comparisons or 

Monolithic Materials Comparisons), click on the Statistics tab in the top menu bar and select either 

Release (mg/kg) or Concentration (mg/L) from the ribbon menu. 
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The following pop-up screen is displayed allowing the user to select the statistics and options for 

calculation. Options include: 

 Basis for interpolation of X-values with editable target values for the grid points 

 Basis for calculating Y-values statistics (i.e., whether statistics are calculated on the reported 
values or a log-transform of the values) 

 Display options for Confidence Limits, Prediction Limits or No Limits (along with mean values). 

Statistical results are shown in the tabbed display at the lower right corner of the window with options 

for showing distributions, graphs, confidence intervals, etc. 
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The displayed constituent may be changed by clicking on Constituent… in the upper left hand corner of 

the window. The Defined Series panel allows for the user to vary what data series are used in the 

statistical calculations and display. The Bulk export… button will allow users to export selected statistics 

and associated graphs to a Microsoft Excel® file for multiple constituents. 

 

The screen below is an example display of the statistics results from the above case with the mean and 

95% prediction limits displayed as dashed lines. 

Change the constituent 
for displayed statistics

Export statistics to 
Excel workbook

Change the data series in 
the statistical 

calculations and displays
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Statistical Calculations from the Import or Add New Data Roll-up Menu 

An alternative approach for accessing statistical functions is through the Import or Add New Data roll up 

menu on the main start up screen. This approach allows for development of more complex statistical 

analyses, and importing the statistical results as additional data sets into the database for display with 

the original data or as comparison lines with other data sets. 
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Under the header Statistics and Merged Replicate Tests, click on Create… to go the to the Leaching Test 

Interpolator and Merger screen.  

 

This tool has been designed to merge multiple existing leaching tests into one, the resulting test being 

the output of a statistical function. 

For example, if you have three replicates of a pH dependence test, you can create a new test, the values 

being the average of the replicates. This new test can be saved and imported into a LeachXS database. 

There are three main steps to take in the merging process. First, the tests to be merged are to be 

selected. After that, the tests need to be interpolated. Interpolation or extrapolation is necessary, 

because statistical data cannot be calculated if time, L/S or pH values of all selected tests are not the 

same. Finally, the desired statistical quantities to output need to be chosen. 

The resulting data sets will be saved in Material Exchange XML format, so that you can import them into 

a LeachXS database. 
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Step 1: Choosing source materials and merge options 

 

From the left pane, select Source material. The top right pane shows the merge options you can choose: 

 Merge Replicates. 

If you have chosen multiple materials each having multiple test replicates, the replicates are merged 

on a per material basis. In this case you will have an additional set of statistical quantities at your 

disposal. 

 Merge All to One. 

All tests you have selected will be merged into one test. You can give the material to create a name 

of your liking. 

 Interpolation only. 

In this case, the tests won’t be merged, but every test will be interpolated only. You can give a suffix 

that will be appended to each material you have selected. 

The bottom right pane will show the materials and tests you have selected. Press the Select… button to 

pick the materials and tests. See “The Sample Selector” on page 121. 
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Step 2: Interpolation 

 

As you can see in the right pane, there are many options to control the interpolation process. The 

options appear if you click on Interpolation in the left pane. 

The Interpolation Type controls how time, pH or L/S values are interpolated. Usually, Linear 

interpolation will do fine, but if the values of the test are very different from the target interpolation 

values, you can experiment with this option. 

The Interpolation grid points are the target interpolation values. Press the Edit… button to edit them. 

See “Interpolation Grid Editor” on page 145 for details. 

If you want to know which values will be interpolated and which will be extrapolated to the target 

interpolation values, given the current interpolation and extrapolation options, press the Interpolation 

Preview button on the ribbon tab page Interpolation. The Interpolation Inspector will show up: 
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You can choose to perform the interpolation on the x-values on a logarithmic bases. This is especially 

apropriate for time and L/S values. Check the Interpolate using logarithmic values for this option. The 

way the concentration (y) values are interpolated can be controlled in the same way, using the Use log 

values for interpolation and statistics.  

Step 3: Choosing statistical quantities 

There are about a dozen statistical quantities to choose from. They appear if you click on Statistical 

Output in the left pane. 
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You can check multiple values. Each value will be output as a separate material. The name of the 

material will be composed of the original name with a suffix appended. The default suffixes are listed, 

but you can change it by double-clicking an entry. When appropriate, you can change the confidence or 

percentile as well: 

 

Below the list is an option to output the interpolated test along with the statistical values as separate 

materials. 

If you have chosen the Merge Replicates option, you have additional statistical options in the Nested 

Statistics Values tab page. 
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Exporting the results 

After you’ve set the options you want, you are ready to save the results in a Material Exchange XML file. 

Save the results by clicking the Save to File button on the File ribbon tab. Before you do that, you can 

choose to create a new file for the results, or append them to an existing file. You can specify this if you 

press the Export link in the left pane. 
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The Sample Selector 

The Sample Selector helps you selecting one or more leaching samples from the database. 

 

 The Application menu contains functions to make screenshots and load recently used lists of 

leaching samples. 

 The Cancel or Save toolbar contains two small buttons to leave the Sample Selector. The red 

one cancels your selection and the green one passes the selection to the module that called up 

the Sample Selector. 

 The Ribbon toolbar contains functions that operate on lists or samples, grouped in ribbon tabs. 

 The Available Samples panel contains leaching sample lists from which you can choose the 

desired samples. 

 The Selected Samples panel contains all the samples that will be passed to the module that 

called up the Sample Selector. 

 The Database icon shows information on the name and location of the active sample database if 

you keep the mouse steady on it. 

Basic Operation 

The Available Samples panel displays a list of samples from the sample database. Not all samples in the 

database may show up. Only those samples that make sense within the context from which the Sample 

Selector is started will be visible. If you check a sample by clicking the checkbox, it will show up in the 

Selected Samples panel, indicating that the sample will be included in the list of desired samples. You 

Application menu Cancel or Save toolbar Ribbon toolbar 

MenuClose/Can

Available Samples panel Selected Samples panel Database icon 
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can also select samples by highlighting samples using the Ctrl and Shift key, and then hit the spacebar: 

all highlighted samples will show up in the Selected Samples panel. 

The checkboxes will not always be present: if the Sample Selector is called from within a context that 

requires only one sample, there will be no checkboxes. In this case, you can select a sample just by 

clicking on it. 

If you are done with selecting samples, click on the small green button with the checkmark on the 

Cancel or Save toolbar. The Sample Selector will close and pass the selected samples to its caller. If you 

want to leave the Sample Selector without using the selection, click on the small red button with the 

cross. 

If there are not many samples in your database, the easiest way to select samples is just scrolling 

through the panel en checking the appropriate boxes. However, if you have a very large database with 

samples, there are many options to sort, group and filter the sample list in order to make it easier to find 

and select samples. 

Manipulating the Sample List 

The Available Samples panel shows columns with extra information on the samples. There are columns 

showing the leaching test type, the test subtype, the material category, the subcategory and finally, an 

indication of the location of the location in the database. Samples last entered in the database have the 

highest location indication. 

Sorting, grouping and filtering samples 

You can sort the list of samples by clicking on one of the column headers. The list is sorted according to 

the information in the column. Clicking the same column header again will reverse the sort order. 

If you use the right mouse button to click on a column header, all grouping and filtering options show up 

in a small context menu: 

 

This screenshot is made when the Name column was right-clicked. 
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To filter the list, check the appropriate initial characters of the sample names that appear to the right of 

the Filtering entry in the menu and click on the Apply button at the bottom of the list. Alternatively, you 

can click on the Clear All Filters entry if you want to remove a filter from a column. 

To group the list, click on the Group by ‘<column name>’ entry in the menu (in this example the column 

is the Name column). The list will look like: 

 

Now, if you click a group heading, all samples in the group will be highlighted. Press the spacebar to 

select them. You can expand or collapse a group by double-clicking a group heading. You’ll find buttons 

on the ribbon toolbar, tab Samples to expand or collapse all groups. 

The grouping is temporary: if you click on another column heading, the list is ungrouped. If you want the 

grouping to remain, right-click on the grouped column heading and select Lock grouping on ‘<column 

name>’ entry in the menu (in this example the column is the Name column). You can unlock grouping as 

well. 

Hiding or showing columns 

At the bottom of the context menu you’ll see a list of column names. If you don’t want hide columns, 

remove the check marks for the appropriate columns by clicking on them. 

More filtering 

Besides filtering the list with the aid of the context menu, the Filter ribbon tab contains more filtering 

options: 
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The Filter by Typing tab group contains a text box where you can type text. The sample names are 

filtered while you are typing text, showing only those samples that contain the text you type. For 

instance, if you type “slag”, the sample list will change to: 

 

If you hit the Enter key in the text box or press the Clear Filter button, the filter is removed. 

Database samples may have extra material properties. You can filter on these properties by clicking on 

Filter Displayed Samples… on the Sample Category Properties ribbon tab. A new filter dialog will 

appear: 
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The display box is divided into several filter categories by a roll up menu on the right side. In the 

example below, the following filter categories are shown: 

 Cement Blend 

 Cement Type 

 Mix Components 

 Mix Composition 

 Sample Information 

 Source 

The filter categories for the US EPA CCR database (USEPA CCR 12-2009 rev1.mdb) will differ from this 

example, but the filtration of materials by filtration category is the same. At the bottom of the screen, 

LeachXS displays the materials corresponding to the filters applied. In the example shown above, no 

filters have been applied and 46 materials are available for display. 

By selecting the appropriate roll up menus and checking the desired filter options, the database is 

filtered. When the desired data sets are located, click the OK button to accept the filtered materials and 

to return to the Sample Selector. The filtered samples will appear in the Selected Samples panel. 

If you have knowledge about the internal sample database structure, you can also filter on values of a 

number of fields and tables in the database. These filter options are on the Other Attributes group on 

the Filtering ribbon tab. 

Roll up Menu
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The Selected Samples panel 

The Selected Samples panel contains the samples you have selected. On tab group Edit of ribbon tab 

Samples there are two buttons to manipulate the selection list. Button Delete will delete the highlighted 

samples from this panel, while button Clear will clear the entire list. 

If you want to see where a selected sample is listed in the Available Samples panel, double-click on a 

sample. The sample in the Available Samples panel will scroll into view. 

Saving and loading sample lists 

Sample lists can be saved for later use; if you foresee that you will use a list of selected samples more 

often, you can save the list with a name of your liking. Loading and saving lists is done with the Case 

Manager. 

If you have created a list of selected samples and want to save the list, click on button Save As… on tab 

group Save Sample Selection of ribbon tab Sample Manager. The Case Manager will show up and 

enables you to save the list. 

If you have opened the Sample Selector and want to use a list that you created and saved earlier, press 

button Open… on tab group Load Sample Selection of ribbon tab Sample Manager. The Case Manager 

will show up, assisting you in selecting your list. 

A quick way to open a previously saved list is by selecting it from the Recently Used lists. You can show 

and select these lists by clicking on the Application menu (the round LeachXS logo). 

You should be aware of the fact that a list of samples you load may not be loaded completely in the 

Selected Samples panel. The list may not (fully) show up in the following circumstances: 

 The list you want to load contains many samples, but from the context of the Sample Selector 

you are allowed to select only one sample. 

 The list you want to load contains leaching test samples that are not valid from the context of 

the Sample Selector. For instance, the list to load contains pH dependence test samples, while 

the context requires selection of monolithic diffusion test samples. 

 The list you want to load contains samples from a different sample database than the one that is 

currently active. 

Favorites list and often used samples. 

You can make a list of selected samples your favorite list by saving the list with button Save Selection as 

Favorites on the Favorites tab group of ribbon tab Sample Manager. If you have designated a list of 

samples to be your favorite, you will always have these samples at your disposal, whenever you use the 

Sample Selector. The list will show up on tab page Favorites in the Available Samples panel. 
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The Sample Selector keeps track of the samples you selected and remembers the 60 most often used 

ones. They appear on tab page Often Used in the Available Samples panel. 

Revealing detailed sample information 

You can inspect more details of a sample by selecting it and press button Show/Hide on the Sample 

Information tab group of ribbon tab Samples. A window like the one below will pop up: 

 

The window will stay on your screen until you press the Show/Hide button again or until you leave the 

Sample Selector. If you select another sample, the content of the window is refreshed with information 

of that sample. You can select a sample from any list you want: from any tab in the Available Samples 

panel or from the Selected Samples panel. 
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The Constituent Selector 

The Constituent Selector helps you selecting one or more constituents from the database. 

 

 The Application menu contains functions to make screenshots and load recently used lists of 

constituents. 

 The Cancel or Save toolbar contains two small buttons to leave the Constituent Selector. The red 

one cancels your selection and the green one passes the selection to the module that called up the 

Constituent Selector. 

 The Ribbon toolbar contains functions that operate on lists or constituents, grouped in ribbon tabs. 

 The Available Constituents panel contains constituent lists from which you can choose the desired 

constituents. 

 The Selected Constituents panel contains all the constituents that will be passed to the module that 

called up the Constituent Selector. 

 The Database icon shows information on the name and location of the active sample database if you 

keep the mouse steady on it. 

Basic Operation 

The Available Constituents panel displays a list of constituents from the active database. If you check a 

constituent by clicking the checkbox, it will show up in the Selected Constituents panel, indicating that 

Application menu Cancel or Save toolbar 

Ribbon toolbar 

MenuClose/Can

Available 

Constituents 

panel 

Selected 

Constituents 

panel 

Database icon 
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the constituent will be included in the list of desired constituents. You can also select constituents by 

highlighting samples using the Ctrl and Shift key, and then hit the spacebar: all highlighted constituents 

will show up in the Selected Constituents panel. 

The checkboxes will not always be present: if the Constituent Selector is called from within a context 

that requires only one constituent, there will be no checkboxes. In this case, you can select a constituent 

just by clicking on it. 

If you are done with selecting constituents, click on the small green button with the checkmark on the 

Cancel or Save toolbar. The Constituent Selector will close and pass the selected constituents to its 

caller. If you want to leave the Constituent Selector without using the selection, click on the small red 

button with the cross. 

If there are not many constituents in your database, the simplest way to select constituents is just 

scrolling through the panel en checking the appropriate boxes. But there are also options to sort, group 

and filter the constituent list in order to make it easier to find and select constituents. 

Sorting, grouping and filtering constituents 

You can sort the list of constituents by clicking on the column header. The list is sorted alphabetically. 

Clicking the same column header again will reverse the sort order. 

If you use the right mouse button to click on the column header, all grouping and filtering options show 

up in a small context menu: 

 

To filter the list, check one or more of the entries that appear to the right of the Filtering entry in the 

menu and click on the Apply button at the bottom of the list. Alternatively, you can click on the Clear All 

Filters entry if you want to remove the filter. 

To group the list, click on the Group by ‘Name’ entry in the menu. The list will have two groups: 

Inorganic and Organic. You can expand or collapse a group by double-clicking on the group heading. 

If you click a group heading, all constituents in the group will be highlighted. Press the spacebar to select 

them. 

You can ungroup the list by clicking on Turn off groups in the context menu. 
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Selecting by using Select by Typing 

Another way of selecting constituents is to make use of the Select by Typing text box. First, move the 

focus to this text box by clicking on it or press Alt+T. Start typing the name of the constituent. While you 

are typing, the first constituent that matches will scroll into view. As soon as the characters you type 

matches a constituent (in a case insensitive way), the text color turns from red to black. Hitting the 

spacebar or Enter key will select the corresponding constituent and clears the text box, so that you can 

continue typing to select another constituent. 

If the text remains red while you are typing, either no match or no full match is found in the constituent 

list. You can check if a partial match is found by looking at the selected constituent in the Available 

Constituents pane. The selected constituent will have a light gray background. If no partial match is 

found, no constituent will be selected. If a partial match is found, and if it is the constituent you want, 

select it by hitting the spacebar twice. The first hit will expand the selected constituent name in the text 

box and the second hit will select it. 

The Selected Constituents panel 

The Selected Constituents panel contains the samples you have selected. On tab group Edit of ribbon 

tab Selection there are two buttons to manipulate the selection list. Button Delete will delete the 

highlighted constituents from this panel, while button Clear will clear the entire list. 

Saving and loading constituent lists 

Constituent lists can be saved for later use; if you foresee that you will use a list of selected constituents 

more often, you can save the list with a name of your liking. Loading and saving lists is done with the 

Case Manager. 

If you have created a list of selected constituents and want to save the list, click on button Save As… on 

tab group Save Selection of ribbon tab Constituent Manager. The Case Manager will show up and 

enables you to save the list. 

If you have opened the Constituent Selector and want to use a list that you created and saved earlier, 

press button Open… on tab group Load Selection of ribbon tab Constituent Manager. The Case 

Manager will show up, assisting you in selecting your list. 

A quick way to open a previously saved list is by selecting it from the Recently Used lists. You can show 

and select these lists by clicking on the Application menu (the round LeachXS logo). 

If you use LeachXS for Orchestra modeling, you probably have used and created species lists. Species 

lists define the mapping of Orchestra species to LeachXS constituents. You can use a species list as list of 

selected constituents by using From Species List… button from tab group Load Selection of ribbon tab 

Constituent Manager. 
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Favorites list and often used constituents. 

You can make a list of selected constituents your favorite list by saving the list with button Save 

Selection as Favorites on the Favorites tab group of ribbon tab Constituent Manager. If you have 

designated a list of constituents to be your favorite, you will always have these constituents at your 

disposal, whenever you use the Constituent Selector. The list will show up on tab page Favorites in the 

Available Constituents panel. 

The Constituent Selector keeps track of the samples you selected and remembers the 30 most often 

used ones. They appear on tab page Often Used in the Available Constituents panel. 
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Graph Window 

The Graph window displays the results you have selected in a graphical way. It serves as a quick preview 

window before you export you results to a Microsoft Excel workbook.  

You can copy any graph in the window to the Windows clipboard or save it to disk. You can inspect point 

values by moving the mouse pointer over a graph area. You can also change the graphical appearance of 

graphs a bit: you can zoom in a graph, reduce or enlarge the size of the legend font and change the 

appearance of the graph. For presentation purposes, you can save a graph on the Windows clipboard or 

a storage medium. All these functions are under the right mouse button. 

 

Highlighting a series 

If there are many series in a graph, it may become difficult to distinguish series from each other. If you 

click on an entry in the legend, that entry and the corresponding series will be highlighted as long as the 

mouse button is pressed. The same will happen if you click on a marked point of a series. If the legend is 

not shown while highlighting a series, a small window will pop up with the name of the series. 
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Viewing coordinates 

When you move the mouse over the plot area of a graph, the exact coordinates of the mouse are 

displayed in the lower left corner of the graph. The coordinates are in the same scale as the plotted 

data. If you move the mouse pointer near a data point in a series, the coordinates will get the same 

color as the series color and the exact coordinates of the data point is displayed. 

Translating, scaling and zooming a chart 

You can translate or scale a graph in any direction, or zoom in on a part of a graph. However, these 

manipulations will be canceled before you export the results to Microsoft Excel®.  

You translate a graph by left-clicking the mouse button, while pressing the Shift key. If you click near the 

X-axis, you can translate along the X-axis. If you click near the Y-axis, you can translate along the Y-axis. 

Drag the mouse along the axis you chose to translate the graph. 

Note that translating along a logarithmic axis will probably not give any meaningful graphs. 

You scale a graph by left-clicking the mouse button, while pressing the Ctrl key. If you click near the X-

axis, you can scale the X-axis. If you click near the Y-axis, you scale the Y-axis. Drag the mouse upward to 

get more detail and downward to get less detail. 

Note that scaling a logarithmic axis will probably not give any meaningful graphs. 

You zoom in on a graph by left-clicking the mouse button, while pressing the Alt key. Create a rectangle 

by dragging the mouse to another point. When you release the mouse button the graph is zoomed to 

the thus created rectangle. 

You can restore the original scaling of the graph by pressing the r key, after you have clicked the graph 

to restore.  

Exporting results 

The Export tab on the ribbon bar contains functions to export selected or all graphs to Microsoft Excel®. 

You can also change layout aspects of a graph to be exported. Select a graph and hit the Edit… button on 

the Export tab. See “General Options” on page 20 to find information on how to change layout aspects. 

General graph layouts 

The View tab on the ribbon bar gives you a number of options to change the overall appearance of the 

Graph Window. 

You can change how multiple graphs are laid out by pressing Landscape or Portrait. 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

134 

If you have a lot of graphs, you may enlarge the plot areas of the graphs by not showing the legend, axis 

titles and axis labels. In tab group Screen Appearance, uncheck entries Show Legend, Show Axis Titles 

and/or Show Axis Labels to remove graph components. 

You can zoom in to a particular graph by selecting it and pressing button Zoom In in the Zoom Selection 

tab group. The selected graph will fill the entire graph window. Press the Zoom Out button to return to 

the full page of graphs. 

Note that you can quickly zoom in to a particular graph by pressing and holding down the middle mouse 

button or scroll wheel. The full page is displayed again if you release the button. 
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Indicator Lines Editor 

An indicator line is a LeachXS concept of a horizontal or vertical line to be shown in a chart. An indicator 

line belongs to a constituent, has properties to format the line and has a value that indicates at what 

position the line is to be drawn. 

Indicator lines are typically used to show detection limits or regulatory directive values in a chart and are 

used in comparison cases. In LeachXS you can create indicator lines and save a set of lines for later use. 

You can edit the contents of indicator line sets and merge them with other sets. More than one 

indicator line per constituent can be present in a set. 

When LeachXS draws a chart that shows data on a constituent, it scans all indicator lines the user has 
selected. LeachXS uses the following procedure to draw the appropriate indicator lines: 

 First, only those lines are handled that belong to the subject constituent in the chart. 

 From these lines, all are picked that have level values defined for the quantities that are plotted 

along the x-axis and the y-axis. 

 The Indicator Lines Editor looks like this: 

 

In the picture above, an existing set of indicator lines is already opened. 

 The Application menu contains functions to make screenshots and load recently used lists of 

indicator lines. 

 The Cancel or Save toolbar contains two small buttons to leave the Indicator Lines Editor. The 

red one cancels your editing and the green one passes the indicator lines to the module that 

called up the Indicator Lines Editor. 

Application menu Cancel or Save toolbar Ribbon toolbar 

Opened Case Constituents panel Lines panel Database icon 
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 The Ribbon toolbar contains functions that operate on the list of constituents or list of indicator 

lines, grouped in separate ribbon tabs. 

 The Constituents panel displays all constituents that are present in the set of indicator lines, 

summarizing the number of horizontal and vertical indicator lines per constituent. 

 The Lines panel shows all the lines and their definitions in the set. 

 The Opened Case field shows the name of the set of indicator lines that is loaded from disk. If 

you have made changes in the set, an icon with a pencil in it will be present, like in the example 

picture. If you keep the mouse steady on the field, you’ll see more details of the case. 

 The Database icon shows information on the name and location of the active sample database if 

you keep the mouse steady on it. 

Loading and saving indicator lines 

All functions to load existing lines from disk or saving them are on the Case Manager tab on the ribbon 

toolbar. 

 

From this toolbar, you can open an existing set of lines (Open…), create a new set from scratch (Create), 

or add a set of lines to the lines already present in the editor (Add From Manager…). The Save and Save 

As… buttons allow you to save the current set of lines. 

Let’s start with an existing set of indicator lines. Press the Open… button. The Case Manager will show 

up. 
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The red groups below System Map store are groups of indicator line sets that are shipped with LeachXS 

and are copied to your system during the installation process. Select group Predefined and then case 

EPA CCR 3e in the right pane. Press the Open button in tab group Manage. Alternatively, you can 

double-click the case name or press the small icon showing a folder in the small toolbar next to the 

Application menu. The Case Manager closes and the indicator lines are loaded into the Indicator Lines 

Editor. The editor should look more or less like the example picture at the beginning of this chapter. 

Organizing and editing indicator lines 

In the Lines panel, all the indicator lines are shown. Every line has the following fields: 

Constituent The name of the constituent the line belongs to. 
Label Text to appear in the chart, near the line. 
Appearance An indication of how the line will look like in the chart. 
Direction The direction of the line. 
Line Type The pattern of the line. 
Line Weight The thickness of the line. 
Line Color The color of the line. 
 

In addition, one or more fields can be used to specify the value of the line: 

pH A pH value. 
L/S (L/kg) A liquid to solid ratio. 
Time (days) A time. 
Concentration (mg/L) A concentration. 
Release (mg/kg) A release. 
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Cumulative Release (mg/m2) A cumulative release. 
Flux (mg/m2/sec) A flux. 
 

One of first three fields is usually used for vertical lines, since these quantities usually are plotted along 

the x-axis. The other fields are common for horizontal lines. 

If you want to edit a line, click on the appropriate cell and type or choose a new value. The Constituent 

field and Appearance field are not editable. 

Sorting, grouping and filtering samples 

You can sort the list of lines by clicking on one of the column headers. The list is sorted according to the 

information in the column. Clicking the same column header again will reverse the sort order. 

If you use the right mouse button to click on a column header, all grouping and filtering options show up 

in a small context menu: 

 

This screenshot is made when the Constituent column was right-clicked. 

To filter the list, check the appropriate constituents that appear to the right of the Filtering entry in the 

menu and click on the Apply button at the bottom of the list. Alternatively, you can click on the Clear All 

Filters entry if you want to remove a filter from a column. 

To group the list, click on the Group by ‘<column name>’ entry in the menu (in this example the column 

is the Constituent column). The list will look like: 
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Now, if you click a group heading, all constituents in the group will be highlighted. You can expand or 

collapse a group by double-clicking a group heading. You’ll find buttons on the ribbon toolbar, tab Lines 

to expand or collapse all groups. 

The grouping is temporary: if you click on another column heading, the list is ungrouped. If you want the 

grouping to remain, right-click on the grouped column heading and select Lock grouping on ‘<column 

name>’ entry in the menu (in this example the column is the Constituent column). You can unlock 

grouping as well. 

Hiding or showing columns 

At the bottom of the context menu you’ll see a list of column names. If you don’t want hide columns, 

remove the check marks for the appropriate columns by clicking on them. 

Editing multiple lines 

Sorting, filtering and grouping can be very convenient if you want to change an aspect of a selection of 

indicator lines. Suppose you want to change the line color of all horizontal indicator lines of Al and Cr to 

silver. First, filter the list on the desired constituents by using the filter options on the Constituent 

column: check constituents Al and Cr in the Filtering list and press Apply. Only the lines of these 2 

constituents will be visible in the Lines panel. Now, group on line direction by right-clicking the Direction 

column and select Group by ‘Direction’. The Lines panel will look like this: 
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Now, click on the Horizontal group heading. All lines in this group will be selected. Press ribbon button 

Edit Multiple Lines… in group Edit of ribbon tab Lines. The Multiple Lines Editor will show up: 

 

The editor shows a list of all aspects of the selected lines. If any aspect in the lines is the same for all 

lines, the aspect is displayed. If not, the aspect is left empty and the phrase (multiple values) is written 

behind it. In this example, the lines only have the same line direction. Press the Change… button to the 

right of the Line Color field and find an appropriate color in the appearing Color Dialog. A 

red/green/blue value of 192,192,192 seems to look like silver. After picking a color, click on the small 

green button with the checkmark on the Cancel or Save toolbar. 
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Starting from scratch 

If you want to create a list from scratch, press the Create button on the Load Indicator Lines tab group 

of ribbon tab Case Manager. An empty set of indicator lines is created with one “constituent” named 

Default Lines. This entry serves as a template for constituents that are added later. Every constituent 

that is added will initially get a copy of the lines that are part of this entry. Suppose we want to make a 

list of lines in which each constituent will have two vertical lines at pH values of 4 and 11, and one 

horizontal line with a variable concentration value. 

In this case it is convenient to give the template these lines and add constituents later. Select the 

Default Lines entry and press button Add Line, tab group Constituents, ribbon tab Constituents trice. 

Three lines are created: 

 

Edit the fields of the lines until it looks like this: 

 

If you add constituents, every constituent will get this set of lines. Add extra constituents with the 

Constituent Selector by pressing the Add button on tab group Constituents of ribbon tab Constituents. 

All you have to do is filling in concentrations for every horizontal line. 

You can make your set permanent by pressing button Save As… on tab group Save Case of ribbon tab 

Case Manager. 
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The Material Line Scheme Editor 

If your graph contains multiple data series, LeachXS uses a default line, color and marker scheme to 

format the series. The default scheme minimizes the chance that two data series have the same layout. 

If you are not happy with the default scheme, you can use the Material Line Scheme Editor to fully 

control the layout of data series.  

A series layout is bound to a sample. If a scheme is defined in a comparison graph, all sample series in 

the graph that have a layout defined in the scheme will be drawn according to their layout. All samples 

that are not included in the scheme will get a layout according to the default scheme. 

 

The Series Layout Pane contains two tab pages. The Full scheme tab contains the current series layout 

details. You can use the Scheme portion tab to edit a subset of the current scheme and merge it later to 

the full scheme. 

The Series Edit Pane contains all the editable aspects of the selected series layouts from the Series 

Layouts Pane. 

The Example Pane shows an impression of how a selected layout will look like. If there are more layouts 

selected, the one that you selected first will be shown. 

Series 

Layouts 

Pane 

Series Edit 

Pane 

Example 

Pane 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

143 

Series Layouts Pane 

Use this pane to make a selection of layouts to be edited. Apart from selecting one or more layouts, you 

can filter, group and sort the layouts by right-clicking a column and choosing the desired option. Using 

these options, you might find it easier to select the layouts you want to edit. 

If you want to add layouts for other samples, go to the Scheme portion tab and press button Load 

Materials on ribbon tab Scheme Portion. You can edit the layouts and then transfer them to the full 

scheme by selecting them and pressing button To Full Scheme on the same ribbon tab. 

Editing Layouts 

You can edit layouts by selecting one or more layouts in the Series Layouts Pane and using the controls 

on the Series Edit Pane to edit them. If you have selected more than one layout, changes you make will 

apply to all selected layouts. The layout aspects you can change are: 

 line and marker color 

 marker symbol 

 marker size 

 line pattern 

 line weight 

Note that you cannot change line and marker color separately: they will always have the same color. 

Saving and Loading Layouts 

You can save schemes to disk and load them for use in e.g. another comparison case. Use the Save, Save 

As… and Open buttons on the Case Manager ribbon tab to save and load schemes. The Case Manager 

will show up to assist you in locating a previously saved scheme or creating a place to save it. See 

“LeachXS Cases and Case Management” on page 100 for more information. 

If you have started the editor from a comparison module, you can save the scheme by pressing the small 

green button in the top left portion of the editor window: the changes in the scheme are made 

permanent and control is returned to the comparison module. 
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Directive selection dialog 

In many instances users want to compare test data with regulatory criteria or limit values. To facilitate 

such comparison a library of regulatory limit values is provided from which a selection can be made. The 

regulations contain separate values for granular and monolithic materials and thus specific regulations 

can only be called in connection with the appropriate test data. 

Besides picking an existing, built-in directive, you can create and edit your own directives. A directive 

has one or more material categories and material categories have limits for granular and monolithic 

constituents. Besides an upper limit, user defined directives can have a lower limit. The lower limits are 

only used in graphs containing directive information, boxing your data between a low and high pH 

values and the upper and lower limits. 

 

The pane on the left, the Directives pane, shows information on the built-in directives (System tab) and 

the directives you created (User defined tab). There are buttons to Add, Remove and Rename user 

defined directives and to Copy an existing directive as a user defined one, giving you a jump start in 

creating a homemade directive. You can add or modify a description of a user defined directive in the 

Directive description pane. 

The Constituents pane on the right, which becomes visible if you select a granular or monolithic section 

of a directive, shows all defined constituents with their limits. You can Remove a selected constituent or 

add new ones by clicking the Add button. “The Constituent Selector” on page 128  will appear, helping 

you in selecting constituents. When a constituent is selected in the Constituents pane, you can edit the 

limits in the fields below the constituent list. 
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Creating and Editing Lists 

Many tools make use of small editors that help you to create lists of values. 

If you want to create statistical data sets from existing samples, the sample series all need to be brought 

to a common set of x-values in order to be properly evaluated. The Interpolation Grid Editor helps you 

to define such a set. 

With the Interpolation Grid Manager, you can make predefined lists of interpolation values. 

With the List Generator, you can generate a list of equidistant values or values whose distances increase 

with a constant factor. 

Interpolation Grid Editor 

With the Interpolation Grid Editor you can create or modify an interpolation grid. 

 

You can add a value by typing it in the row starting with an asterisk. Delete a value by selecting the row 

to be deleted and press the Delete button of your keyboard. To edit a value, double-click it and type the 

new value. 

After you have edited or added values, the values can be sorted in ascending or descending order by 

clicking the column header. 

If you want to create an equidistant list of values, you can use the options on the Equidistant filling 

ribbon tab. Define a start and end value, the number of values and the list is filled with equidistant 

values. If you check the Log distribution box, a logarithmic (base 10) distribution is used, the powers 

being uniformely distributed. 

You can also use functions from the Fill ribbon tab to select a list of predefined values or generate a list 

of non-equidistant values. 
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Choose a defined list from the choices in Available List, or press Define Range… to fully control how the 

list is built up. See “Interpolation Grid Manager” on page 146 for managing the available lists or “List 

Generator” on page 147 for creating a non-standard list of values. 

Interpolation Grid Manager 

When you want to create reference data sets from statistical values, the first step to take is aligning the 

pH, L/S or time values of your source data to a uniform set of values by means of interpolating the 

original data. You can choose to manually define a set of values, but LeachXS offers a number of 

predefined lists that are used commonly. The Interpolation Grid Manager can be used to add or modify 

these predefined lists. It can be called from the main LeachXS window on tab page Tools, button X-Grid 

Interpolation Manager. 
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This editor shows you all predefined list, grouped by entity. 

Add a new predefined list by selecting the group name of the desired entity and press the New List… 

button. The Interpolation Grid Editor will show up, allowing you to type in the values you want in the 

list. 

If you want to delete a predefined list, select it and press the Delete button. 

If you want to change the name of a list, select the list and hit the F2 button. If you want to edit the 

contents of an existing list, selected and press the Edit… button. the Interpolation Grid Editor will show 

up. 

All your changes will be saved automatically if you close the editor. 

List Generator 

The List Generator can generate a series of values. 
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To create a list of equidistant values, check the Linear radio button and fill in the number of steps to 

create and the last value. 

To create a list of values, whose distances increase with a constant factor, check the Factorial button 

and fill in the desired number of steps, the end value and the factor by which successive distances 

increase. 

You can also type the list of values by hand. Check the Manually radio button and type the values, 

separated by semicolons. 

The bottom pane gives you an impression of how successive distances relate to each other. 
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Technical Topics 

File locations 

This section gives an overview where LeachXS stores or expects files. The following symbolic names are 

used for file locations: 

 

Location name Physical location 

[Install location] C:\Program Files (x86)\LeachXS Lite 

This location is the default location where LeachXS is installed. You 
might have chosen a different location during the installation process of 
LeachXS. 

[Application data] C:\Users\<username>\AppData\Roaming\LeachXS Lite 

[Local Application data] C:\Users\<username>\AppData\Local\ECN_TSC 

[User data] C:\Users\<username>\Documents\LeachXS User Objects 

[Template location] C:\Users\<username>\AppData\Roaming\Microsoft\Templates 

 

The phrase <username> denotes the name you use to log on to your computer. 

Software Modules 

All software modules are installed in [Install location]. 

License 

Your license is encrypted in file: [Application data]\About.lxs. If, for some reason, you want to change 

your license, remove this file. The next time your start LeachXS you will be prompted for a username 

and license key. 

Window states 

LeachXS remembers the state of all windows. The main state parameters are window size and position, 

minimized/maximized or normal size and on what screen the window is displayed, if you use more than 

one screen. Some windows and dialogs remember the last state of checkboxes, combo boxes, radio 

buttons and other user interface controls as well. The states are stored in:  

[Local Application data]\ LeachXS_Lite.exe_Url_<key>\<version>\user.config,  

where <key> is a unique series of characters and <version> is the version of LeachXS you are using. 

Most Recently Used cases 

Every module that is capable of editing, loading, creating and saving cases keeps track of the cases that 

have been used. The 10 most recently used ones are remembered and stored in: 

[Application data]\MruLists\<casetype>.mru, where <casetype> is an indication of the type of case. 
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Databases 

The default location of all LeachXS databases with samples is [User data]\DATABASES. All databases that 

are shipped with the installation procedure of LeachXS are stored here. LeachXS presents the content of 

this location by default if you want to select a database. However, you are free to store a database 

anywhere you like. 

Software License 

Your software license is encrypted in the following file: [Application data]\About.lxs. If you need to 

switch from license, remove this file. LeachXS will prompt for a username and license key next time you 

start it. 

Pre-installed examples 

When LeachXS is installed, example cases are installed as template for new cases, giving you a head 

start. All these examples are in folder [Application data]\FactoryDefaults. Cases for a specific type of 

examples all have their own subfolder. 

Note that pre-installed examples are read only. You cannot overwrite them. Don’t save your own cases in 

the folder with pre-installed examples. 

User Cases 

All cases you make yourself are stored by default in a separate folder: [User data]. Cases of a specific 

type all have their own subfolder. You can make alternative locations for cases. These locations are 

called Map Stores. You can create them in the Object Manager. See “LeachXS Cases and Case 

Management” on page 100. 

Templates for lab data input 

LeachXS installs data templates that you can use in Microsoft Excel® for entering data on leaching tests. 

Among them are data templates for EPA methods 1313, 1314, 1315 and 1316. You’ll find them in folder 

[Template location]. This location is the same as where Microsoft Excel® assumes that user templates 

are located. 

CSTR calculation 

The CSTR fitting is done by performing a weighted linear regression of the natural logarithms of the 

concentration values. The result of the weighted linear regression is a slope (A) and offset (B). 

The following function is minimized: 

2

1

2 ),( 











 


N

i i

ii

Sig

BXAY
BA  

 



LeachXS  CBP Version 2.0 User’s Guide (rev. 0) 

151 

Where: 

N Number of points. 
i Index of point (between 1 and N). 
Xi ith L/S value. 
Yi ln(Ci). 
Ci Concentration of ith point. 
Sigi Estimated uncertainty of Yi. 
 

The CSTR curve value in point Xi can be obtained from: 

iBXA

i eeCSTR


  

Weights 

No weighting: 
Sigi = 1 for i between 1 and N. 

Standard weighting: 
Sigi = 0.05 * Yi 

Favor low/midrange/high L/S values: 
First, create 3 XW values: 

XW1 = ln(X1) 
XW3 = ln(XN) 
XW2 = 0.5 * (XW1 + XW3) 

Now, create 3 YW values, depending on the range to favor: 
Favor low L/S values:  

YW1 = 1, YW2 = SQRT(10), YW3  = 10. 
Favor midrange L/S values:  

YW1 = 10, YW2 = 1, YW3 = 10. 
Favor high L/S values:  

YW1 = 10, YW2 = SQRT(10), YW3  = 1. 
 
Then, a polynomial of degree 2 is fitted through the three points (XWi,YWi). 
The uncertainties are constructed by: 

Sigi = Polynomial(ln(Xi)) 
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